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概述Overview
 八思量简版软件简介

A Brief Introduction to the SeaThinking Simplified Version Software

软件简介 Software Introduction
八思量简版software supports Unicode and can run in several operating systems of the Microsoft Windows series, including Windows 7, Windows 8 and Windows 10. All the following descriptions in this manual are applicable to the currently predominant Microsoft Windows 7 operating system by default.
SeaThinking Simplified software can run on a variety of Microsoft Windows operating system platforms, including Windows 7, Windows 8 and Windows 10. All the following descriptions in this manual are applicable to the currently predominant Microsoft Windows 7 operating system by default.

八思量简版software is an simplified version of SeaCAD 5.X，主要精简了一下不常用的高级功能，增强了软件的稳定性。

SeaThinking simplified version software is an simplified version of SeaCAD 5.X, which mainly simplifies the advanced functions that are not commonly used, and enhances the stability of the software.
八思量简版软件is installed in a green way: extract the installation package into any directory in the hard disk, and then double click the SeaCAD.exe under the directory to run the software. See the following figure.

SeaThinking simplified version software is installed in a green way: extract the installation package into any directory in the hard disk, and then double click the SeaCAD.exe under the directory to run the software. When the software starts, it will automatically detect the marking card device， See the following figure.
[image: image2.png]There is no valid card to use! the software will work in demo mode





未检测到激光器控制卡，请检查设备与电脑连接线，并让设备重新上电

No laser control board detected. Please check the connection line between the device and the computer and power on the device again

未检测到板卡

No board detected card
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Fig.1-1 Software Initial
Software Function
Software has the following main functions：
●   User can Design their graphics freely pattern .
●   Supports multiple document editing, multiple documents, multiple cards, and multiple laser types marking simultaneously.
Supporting all the fiber lasers, CO2 lasers and end-pumped lasers in the market. The parameters, such as the electric current, impulse frequency and duty ratio, can be set and adjusted through the software according to different laser types.

 Support separate red light marking indication.   
Software the Providing use jurisdiction control to prevent the parameters from being modified at random.
Provide basic IO control function: through port control,enabling your machine easily implementation automation control。

Provides manual correction, and nine point correction methods to obtain extremely accurate 2D marking effect.
Provide extended axis function：supporting extended axis to rotate according to the angle，such as rotary marking.

Support filling operation: provide line and ring filling, can be filled at any angle, cross filling, margin, border, spacing and other adjustable. Support up to four layers of filling combination, each layer can set parameters independently

Providing the variable text function: fixed text, serial number, date of , time, TCP/IP communication, serial Interface communication, SQL database, etc.

Supporting 256-layer marking parameters: supporting the parameters of each layer to be set randomly to easily realize multi-parameter marking.

Supporting image files such as PLT, DXF, BMP, JPG and JPEG.
Supporting the common 1D/2D barcodes, such as Code39, EAN, PDF417 and DM.
   Provide text input function, support True Type fonts, single line fonts, bar code fonts, and Autonomy add (dot matrix fonts, etc.) fonts.
Supporting the dynamic file marking. When the text and graphs are marked, the filename is fixed, but the file content will be changed.

Providing powerful editing function: supporting the arc arrangement of characters, any graph drawing/editing, uncombining/combining, grouping/ungrouping, undoing/redoing, plastic, etc. 

   Providing the simulation function: You can preview the marking trajectory of the graph before marking operation
Supporting secondary development: providing the SDK secondary development library, supporting the user to customize the development, expanding the functions of the existing marking system and meeting the user’s requirements in special applications.

提供多达12种的语言支持，满足大部分需求

Providing up to 12 kinds of language support to meet most needs

Interface Introduction
Starting initial interface

Starting to run the program, startup interface (Figure 1-2) is displayed, and the program initializes in the background.
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Fig.1-2 Program Starting Interface
Main interface
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Fig.1-3 Main Program Interface
About 八思量简版 User’s Manual 
About SeaThinking Simplified Version User’s Manual
Contents Arrangement
This manual will introduce the usage of 八思量简版软件 according to the order of the menu bar in the main interface, It includes ten main menus, including file, draw, edit, modify, special, status bar, laser, view, galvanometer correction, help, object bar and marking control bar.

This manual will introduce the usage of SeaThinking simplified version software according to the order of the menu bar in the main interface, It includes ten main menus, including file, draw, edit, modify, special, status bar, laser, view, galvanometer  galvo, help, object bar and marking control bar.

 Other declarations
 Due to the actual operation mode and function settings caused by software upgrade, the contents of this manual may not be updated in time. In case of any inconsistency with this manual, the software shall prevail.
Other product and company names mentioned herein may be the trademarks of their respective owners.

Instructions of Software Installation

This software is green software and can run immediately after extracted.
When the software starts and the reminder of “xxxx.dlll cannot be found” appears, carry out vcredist_x86_2010.exe to install the system patch.
2. File Menu

The File Menu is used for common file operations, such as “New”, “Open” and “Save”, as well as functions like system parameter setting and common graph library maintenance. See Fig. 2-1.
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新建 New 
打开 Open
关闭 Close
保存 Save
另存为(A)...  Save As (A)...
矢量文件 Vector File
图片文件  Image File
打印Ctrl + P  Print Ctrl + P
获取扫描图象（m）... Get Scan Image (m)...
系统参数  System Parameter
Fig. 2-1 “File” Menu
2.1.New(N)

“New” Submenu is used for creating a blank workspace to construct objects, and its shortcut key is “Ctrl+ N”. 

“New” Submenu corresponding toolbar Icon for [image: image7.png]


. Clicking on this icon will achieve the same operation.

When you move the mouse pointer to the toolbar to create a new icon and pause a little, the system will display a prompt message to briefly explain the function of the icon, and the status bar below the main interface window will display a slightly detailed explanation of the function. If you move the mouse pointer over the new submenu in the menu bar, only a detailed explanation will appear in the status bar, and the prompt will not appear.

[Reminder: in the八思量简版software, each icon in the Toolbar has a function of showing brief prompt information and the Status Bar has a function of displaying detailed explanations. Also, each icon has a corresponding menu item, and both the two ways carry out the same function. The User’s Manual will not mention it again in the following chapters.]

[Reminder Tips: in the SeaThinking simplified version software, each icon in the Toolbar has a function of showing brief prompt information and the Status Bar has a function of displaying detailed explanations. Also, each icon has a corresponding menu item, and both the two ways carry out the same function. The User’s Manual will not mention it again in the following chapters.]

2.2.Open(O)

“Open” Submenu Used to open an .orz file saved on your hard disk, Its shortcut key is Ctrl + O. When the open submenu is selected, system A dialog box will appear to open the file (Fig. 2-2). Ask you to select the file you want to open. When you select a valid .orz file, A preview graphic of the file is displayed below the dialog box.
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Fig. 2-2 “Open” Dialog Box

Toolbar icon for the open submenu is [image: image9.png]


.
打开 Open
查找范围（I）：Look in (I): 
工作图片 Work Images
名称 Name
日期 Date
类型 Type
大小 Size
标记 Marking
警告（无引用）.orz   Warning (No Reference).orz

打开 Open

取消 Cancel 
显示预览 Display Preview
2.3.Save(S) Save As(A)

The save submenu saves the drawing with the current file name, and the save as submenu saves the drawing with another file name. Both realize the function of saving files.

If the current file already has a file name, the Save command saves the currently drawn drawing with that file name. Otherwise, the save file dialog box will pop up, asking you to choose the path to save the file and provide the file name. No matter whether the current file has a file name or not, the save as command will pop up the Save As dialog box (Figure 2-3), asking you to provide a new file name for saving to avoid the old file being overwritten.
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Fig. 2-3 “Save As” Dialog Box
The icon of “Save” in the Toolbar is [image: image11.png]


.
另存为 Save As
库 Library
文档 Documents
收藏夹 Favorites
下载 Downloads
桌面 Desktop
最近访问的位置 Last Visited Location
库 Library
视频 Videos
图片 Images
文档 Documents
文档库 Document Libraries
包括：2个位置  Including: 2 Positions
排列方式：文件夹  Arrangement: Folders
名称 Name
修改日期 Modified Date
文件名（N）：无标题.orz  File Name (N): Untitled.orz
保存类型（T）:  Save Type (T):
隐藏文件夹 Hide Folders
保存  Save 
取消 Cancel
2.4.Print

Print is used to print current image and its shortcut key is “Ctrl+ P”.

The shortcut key for printing is Ctrl + P, which is used to print the current drawing.

2.5.  Get scanned image (m)

‘Obtain Scan Image’ submenuis used to get images from specific external devices. Selecting this command will bring up the dialog box shown in Figure 2-4. Requires the selection of an external device (the listed devices are legitimate drivers already installed on your computer). When an external device is selected, the corresponding device image processing dialog box appears. You can select the corresponding image input. (The dialog box varies depending on the device. Please refer to the corresponding device operating instructions.)

[image: image12.png]



Fig.2-4  Get scanned image
选择来源 Select Source
来源： Source:
选定  Selected
取消  Cancel
2.6.System configs (P)

“System configs” submenu is used to set the system parameters. Select "system parameters" menu and a dialog box as shown in Figure 2-5 will pop up. In this dialog box, you can set general parameters of software, displayed color, parameters related to working range, user management and other parameters.
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Fig. 2-5 “System configs” Window

The icon of ” System configs” in the Toolbar is [image: image14.png]


.
系统参数   System configs
常规 General
颜色与样式 Color and Style
工作区间 Workspace
自定义快捷键 Custom Keyboard Shortcuts
自动保存 Auto Save
移动旋转 Move-Rotate
用户管理 User Administration
语言 Language
水平对齐间距  Horizontal Alignment Spacing
垂直对齐间距  Vertical Alignment Spacing
水平粘贴偏移  Horizontal Paste Offset
垂直粘贴偏移  Vertical Paste Offset
平滑系数  Smoothing Coefficient
（注：系数越小，点越多，越平滑）

(Note: The smaller the coefficient, the more points, the smoother)

显示网格  Display Grid
网格间距  Grid Spacing
输入IO掩码  Input IO Mask
输出IO掩码  Output IO Mask
当主程序启动时，运行程序  Run the program when the main program starts 
程序启动时自动创建一个空文档  

Create an empty document automatically when the program starts

当主程序关闭时，运行程序  

Run the program when the main program is closed

多卡标刻自动退出窗口  Multi-card marking exits the window automatically 
最大设备数 Maximum Number of Devices
确定  OK
关闭  Close
2.6.1. Conventional
In Conventional, mainly set some general parameters

Horizontal paste / vertical paste offset: specifies the offset of the, newly generated object (be pasted object) relative to its original position when you use the copy / paste function. As shown in Figure 2-6:

[image: image15.png]



Fig. 2-6 Original Graph and Copied and Pasted Graph
“Smoothing Parameter”: controls the smoothness of the vector diagram generated by the software.

“Grid”: shows or hides the grid.

“Grid spacing ”： Distance between gridlines

“Execute when SeaCAD Starts，Run SeaCAD program”/“Execute when SeaCAD Finish，Execute when SeaCAD Starts，Run SeaCAD program”: start the executable programs provided by the third party to realize some relevant operations. 

Open a new file when SeaCAD Starts：a new file named "SeaCAD1" is automatically created after the software is opened.

“Input IO Mask”: sets the input port supported by the current software.
“Output IO Mask”: sets the output port supported by the current software.
2.6.2.c

“Color” is used for setting the color of background, workspace, centerline and grid, etc. Double clicking the color stripe could change the corresponding color. See Fig. 2-7.
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    Fig. 2-7 Color Setting
系统参数  System Parameters
常规  Conventional
颜色与样式 Color and Style
工作区间 Workspace 
自定义快捷键 Custom Keyboard Shortcuts
自动保存 Auto Save
移动旋转 Move-Rotate
用户管理 User Administration
语言 Language
背景Background
网格： Grid:
辅助线  auxiliary Line
中心线 Center Line
界面UI样式 cc

确定  OK
关闭  Close
2.6.3. working area 
“ working area” is used for setting various parameters in the operating area, enabling the user to customize them based on his habits. See Fig. 2-8.
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Fig. 2-8  working area Setting
系统参数  System Parameters
常规 General
颜色与样式 Color and Style
工作区间 Workspace
自定义快捷键 Custom Keyboard Shortcuts
自动保存 Auto Save
移动旋转 Move-Rotate
用户管理 User Administration
语言 Language
显示非标刻图元 Display Non-marking Metafile
显示工作区间 Display Workspace
显示圆形区间 Display Circular Interval
显示中心十字线 Display Center Cross Line
左下角 Lower Left Corner
X  -50 毫米  X  -50mm
Y  -50 毫米  Y  -50mm
尺寸  Size
宽度  100毫米  Width 100mm
高度  100毫米  Height 100mm
确定  OK
关闭  Close
图
2.6.4. 自定义快捷键 Custom Keyboard Shortcuts 

用于设置软件各项功能所对应的快捷按键。

It is used to set the shortcut keys corresponding to various functions of the software.
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2-9 自定义快捷键Custom Keyboard Shortcuts

系统参数  System Parameters
常规 General
颜色与样式 Color and Style
工作区间 Workspace
自定义快捷键 Custom Keyboard Shortcuts
自动保存 Auto Save
移动旋转 Move-Rotate
用户管理 User Administration
语言 Language

	功能

Functions
	快捷键

Keyboard Shortcuts
	编辑文本时禁用

Disable When Editing Text

	单卡标刻

Single Card Marking
	F2
	No

	单卡红光

Single Card Red Light
	F1
	No

	参数设置

Parameter Settings
	F3
	No

	重置工作区布局

Reset Workspace Layout
	Ctrl + Alt + R
	No

	多卡标刻

Multi-card Marking
	[Not Set]
	No

	新建文件

New File
	Ctrl + N
	No

	打开文件

Open File
	Ctrl + O
	No

	保存文件

Save File
	Ctrl + S
	No

	文件另存为

Save File As
	Ctrl + Alt + S
	No

	关闭文件

Close File
	Ctrl + W
	No

	退出程序

Exit Program
	[Not Set]
	No

	开关捕捉网络

Toggle Snap Network
	F7
	No

	开关捕捉辅助线

Toggle Snap Guide Line
	F8
	No

	开关捕捉对象

Toggle Snap Object
	F9
	No

	删除选中图元

Delete Selected Metafile
	Delete
	Yes

	图元上移

Metafile Move Up
	Up
	No

	图元下移

Metafile Move Down
	Down
	Yes

	图元左移

Metafile Move Left
	Left
	Yes

	图元右移

Metafile Move Right
	Right
	Yes

	图元大比例上移

Metafile Move Up in Large Scale
	Shift + Up
	Yes

	图元大比例下移

Metafile Move Down in Large Scale
	Shift + Down
	Yes

	图元大比例左移

Metafile Move Left in Large Scale
	Shift + Left
	Yes

	图元大比例右移

Metafile Move Right in Large Scale
	Shift + Right
	Yes


使用默认配置  Use Default Settings
确定  OK
关闭  Close
2.6.5. Auto Save

“Auto Save” is used for setting the interval time between two automatic saves, so as to efficiently prevent missing file in case of any emergency (such as power failure or dead halt). According to the set interval time, the current data is saved in the file named “autosave.orz’ in SeaCad’s directory. See Fig. 2-9.
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Fig. 2-10 Auto Save Setting

系统参数  System Parameters
常规 General
颜色与样式 Color and Style
工作区间 Workspace
自定义快捷键 Custom Keyboard Shortcuts
自动保存 Auto Save
移动旋转 Move-Rotate
用户管理 User Administration
语言 Language

每5分钟自动保存  Auto Save Every 5 Minutes
每过指定时间间隔将当前数据保存到程序目录下的AutoSave.orz文件中
Save the current data to the AutoSave.orz file in the program directory every specified time interval

2.6.5.Move-Rotate

    fine adjustment： refers to the distance that the selected object moves each time when the direction key is pressed, if the direction keys of the keyboard are used for moving the graphs.

    Large adjustment: If the distance to be adjusted is long, synchronously pressing direction keys and “shift” key will enable the selected object to move for a distance of Nudge Distance* Large adjustment. 
Rotate Angle: refers to the angle the object rotates each time when direction keys and “ctrl” key are pressed together.

 Homing method: determines which point of the object should be put on the origin when the “Put to Origin” function is used. SeaThinking simplified version software divides each graph into 9 position points (0-8). “Object’s Origin” can be set by positioning the graph accurately at the user’s will. Fig. 2-9 shows the origin setting based on Position 1. After the graph is drawn in the workspace of the software, click [image: image20.jpg]


 (Put to center) button: 
[image: image21.png]



Fig. 2-11 Example of “Homing method”
2.6.6.User Management
It is used for setting whether the user password shall be input to use the current software, as shown in Fig. 2-11.

When “Enter the Password before Using” is selected, the system is configured with one administrator, one designer and one Draftsman by default, but the user can add operators.

管理者拥有能够使用软件所有功能的权限，切不可以更改权限。

The administrator has the permission to use all functions of the software, and must not change the permission.
其他使用者的权限都可以自行设置。

The permissions of other users can be set by themselves.
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     Fig. 2-12 User Management
系统参数  System Parameters
常规 General
颜色与样式 Color and Style
工作区间 Workspace
自定义快捷键 Custom Keyboard Shortcuts
自动保存 Auto Save
移动旋转 Move-Rotate
用户管理 User Administration
语言 Language

使用软件必须输入密码  You must enter the password when you use the software
用户 User
管理者 Administrator

设计者 Designer
增加 Add
修改 Modify
删除 Delete
保存权限设置 Save Permission Settings
	通用加工

General Processing
	是

Yes
	否

No

	创建文件

Create File
	是

Yes
	否

No

	编辑文件

Edit File
	是

Yes
	否

No

	系统设置

System Settings
	是

Yes
	否

No

	参数设置

Parameter Settings
	是

Yes
	否

No

	打开文件

Open File
	是

Yes
	否

No

	保存文件

Save File
	是

Yes
	否

No


确定  OK
关闭  Close
2.6.7.Language

It shows the language package installed in your computer. You can use it to change the language used in the interface of SeaThinking simplified version software. The change will not take effect until the software is restarted next time. It has Chinese simplified, Chinese traditional, English, Korean and other 11 language packages by default.
2.7.Common Graph Library  (此功能已取消)
This function can import the graphs frequently used to the common graph library for use at any moment. The specific procedures are as follows:

1. Save the graph library file

First of all, draw or import drawings in your workspace that you want to store in a common library, select that graph, open the “File”/“Common Graph Library” dialog box, then click “New Graph Library” to enter the name of the new graph library in the “New Graph Library” dialog box, and click “OK”. as shown in Fig. 2-13:
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图2-13 “常用图库”对话框

Figure 2-13 “Common Graph Library” Dialog Box

常用图库 Common Graph Library
图库名称 Graph Library Name
图片预览 Image Preview
提示：按住鼠标左键选择需要的图形然后拖拉移动到工作区间

Tip: Hold down the left mouse button to select the desired graphs and drag them to move to the workspace
常用图形 Common Graphs
新建图库 New Graph Library
请输入图库名称 Please Enter the Library Name
确定  OK
取消 Cancel
新建图库 New Graph Library
删除图库 Delete Graph Library
加入图片 Add Image
删除图片 Delete Image 
When the graph library is created, add the graph to be saved. Select the graph in the workspace, click “Add Graph” to enter the graph name, and click “OK” to save the graph selected in the work pace in the “Common Graph Library”.

2. Copy the graph from the graph library

If the graph in the graph library is to be copied, open the common graph library and drag the graph to be used to the workspace by pressing the left mouse button.as shown in Fig. 2-14:
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         Fig.2-14 Copy the graph from the graph library
常用图库 Common Graph Library
图库名称 Graph Library Name
图片预览 Image Preview
提示：按住鼠标左键选择需要的图形然后拖拉移动到工作区间

Tip: Hold down the left mouse button to select the desired graphs and drag them to move to the workspace
常用图形 Common Graphs
新建图库 New Graph Library
确定  OK
取消 Cancel
新建图库 New Graph Library
删除图库 Delete Graph Library
加入图片 Insert Image
删除图片 Delete Image 
2.8.Recent File List
Below “System Parameter”, a list is displayed to show the files recently opened by the user. If the user has never opened/saved any “.orz” file, such a list will not appear.

2.9.Exit (X)

It is used for exiting the 八思量简版 software. If any file is not saved, the system will ask you whether to save it. 

It is used for exiting the SeaThinking simplified version software. If any file is not saved, the system will ask you whether to save it.

2.10.Object List window
Object List is in the left side of the main interface of 八思量简版 software, as shown in Fig. 2-14: 

Object List is in the left side of the main interface of SeaThinking simplified version software, as shown in Fig. 2-14:
[image: image25.png]
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Fig. 2-14 Object List
对象列表窗 Object List Window
	名称Name
	类型Type
	标记Marking

	矩形1 Rectangle 1
	矩形Rectangle
	

	文本1 Text 1
	文本Text
	

	圆（弧）1 Circular (Arc) 1
	圆（弧）Circular (Arc)
	


Note: during marking, the system will follow the order in the object list (from top to bottom) to mark the listed objects（3D图元除外）。

Note: during marking, the system will follow the order in the object list (from top to bottom) to mark the listed objects. (Except for 3D metafiles). 

The user can rearrange the list by directly dragging the object or through the right key.

The user can double click the object name to rename it.

2.11.Object Properties Window
Object Properties Window is displayed in the left side of the main interface of the software, as shown in Fig. 2-15.
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Fig. 2-15 Object Properties Window
对象属性框 Object Property Box
位置 Location
尺寸 Size
阵列 Array
应用 Apply
圆角程度 Fillet Degree
所有边圆角 All Edge Fillet
X Position: Represents the X coordinate of the currently selected object，This coordinate can be specified as the coordinate of the lower left corner of the object，You can also specify coordinates for the center of an object，Through coordinate information button，[image: image28.png]


To set the specific meaning of position coordinates.

Y Position: Represents the Y coordinate of the currently selected object，This coordinate can be specified as the coordinate of the lower left corner of the object，You can also specify coordinates for the center of an object，Through coordinate information button，[image: image29.png]


To set the specific meaning of position coordinates.
Z Position: Said that the current the Z coordinate of the selected object.

X Size: Said that the current the width of the selected object.

Y Size: Said that the current the height of the selected object.

[image: image30.png]


: locks the current length/width ratio of the selected object. If the user changes X and Y Sizes, the system will keep the length/width ratio of the new size unchanged.

Coordinate information Button[image: image31.png]


: specified whether X position and Y position correspond to the coordinates of the left bottom corner or center of the object or other given positions. When the user clicks this button, a dialog box will appear to ask the user to select the position corresponding to the coordinate. The coordinate data displayed currently indicate that X Position and Y Position correspond to the coordinates of the object’s left bottom corner.

Array [image: image32.png]Array



 ：Copy the current object to the specified location, and the operation dialog box is as shown in Figure 2-16:

[image: image33.png]



Fig. 2-16 Array Operation Dialog Box
阵列 Array
阵列Array
数目 Quantity
增量 Increment
使用间距方式 Use Spacing Method
确定  OK
关闭  Close

Increment: Refers to the user specified row spacing and column spacing.

Figure 2-17 is the Array Number， X=3、Y=2 object situation
[image: image34.png]



Fig. 2-17 Array Operation Result
[image: image35.png]


: Indicates the array direction is horizontal priority

[image: image36.png]


: Indicates that the array is unidirectional.

[image: image37.png]


: Indicates that the array is a two-way array.
3. Edit Menu

The “Edit” menu carries out the editing operation of a graph, as shown in Fig. 3-1.
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Fig. 3-1 “Edit” Menu
编辑 Edit
绘制 Draw 
修改 Modify
查看 View
撤销 Undo
恢复 Redo
剪切 Cut
复制 Copy
粘贴 Paste
全选（A） Select All (A)
反选 Select Invert
删除 Delete
组合 Combine
分离组合 Uncombine
群组 Group
分离群组 Ungroup
转为曲线 To Curve
转为虚线 To Dashed Line
偏移 Offset
分离文本 Ungroup Text
3.1.Undo (U)/ Recovery (R)

During graph editing, if the current operation is not satisfying, “Undo” can be used for undoing current operation and bring the previous operation back; after the current operation is undone, “Redo” can be used for redoing the undone operation. This is one of functions most frequently used in editing.

The icon of the “Undo” menu in the Toolbar is [image: image39.png]


, while the icon of the “Recovery” menu in the Toolbar is [image: image40.png]


. Similar to most software, those two operations have their corresponding shortcut keys, i.e. Ctrl+Z and Ctrl+Y respectively.
3.2.Cut (T), Copy (C) and Paste (P)

“Cut” will delete the selected graph and copy it to the clipboard of the system. Then “Paste” will copy the graph in the clipboard to the current graph. “Copy” will copy the selected graph to the system clipboard and keep the original graph.

The shortcut keys of “Cut”, “Copy” and “Paste” are Ctrl+X, Ctrl+C and Ctrl+V respectively. 

The position of the pasted figure and the position deviation from the original figure are determined by the paste displacement in the conventional parameters of the system parameters

3.3.Combination/ Separation Combination 

“ Combination” will ignore all the selected objects’ original properties and combine those objects into a new curve object. This combined graph, like other graphs, can be selected, copied, pasted and its properties can be set. For example, when the original graph is a circular or a rectangular, but the graph after “ Combination” operation is dealt with as a curve and will be transformed into a curve after “Separation Combination” operation.

“Separation Combination” Restore combination objects to individual curve objects

“Combination” The toolbar icon corresponding to the menu is[image: image41.png]


,“Separation Combination” The toolbar icon corresponding to the menu is[image: image42.png]


. Their shortcut keys are Ctrl+L and Ctrl+K respectively.
3.4.Group/ Separation Group
“Group” will keep the selected objects’ original properties and make them into a new object, and this new graph, like other graphs, can be selected, copied and pasted, and its properties can be set. 

For example, the original graph is circular or rectangular, but the graph after “Group” operation will be dealt with according to the original properties and it will be restored to the original graph, with properties unchanged, after “Separation Group” operation.

“Separation Group” Restore the objects of the group to the state before the collection.

The icon of “Group” in the Toolbar is [image: image43.png]


, while that of “ Separation Group” is[image: image44.png]


. Their shortcut keys are Ctrl+G and Ctrl+U respectively.
3.5. Turn to curve

Remove the attributes of the selected graphic object and turn it into a curve object.

3.6. Turn To a Dashed Line 

This function is to transform the vector graph to a dashed graph for marking, as shown in Fig. 3-2:
[image: image45.png]Turned to a dotted line





Fig. 3-2 “Turn to a Dashed Line”

The user has to set the length of the short line and the space between lines, and then click “OK” to transform the vector graph into a dashed one.
转为虚线 To Dashed Line
确定  OK
取消 Cancel
线长 Line Length
间隔 Interval
3.7.Offset

点击偏移后会在对象列表窗上面多出一条操作条。

After clicking the offset, an additional operation bar will appear on the top of the object list window.
[image: image46.png]



偏移距离 1毫米  Offset Distance  1 mm
删除旧曲线 Delete Old Curve
对象列表窗 Object List Window
SeaCAD1

将绘制的矢量图形按照偏移距离进行偏移操作。功能选项如左图3-3所示：

Offset the drawn vector graphs according to the offset distance. The options are shown in Figure 3-3 on the left:
Offset  distance：Refers to the distance between the offset figure and the original figure.
Del Old curve：Whether to keep the original graphics. Unchecked means to keep the original graphics. Check to remove the original graphics and keep only the offset.

 3.8. Separate text
Separating character text string into multiple text objects that contain only one character

3.8.Ungroup Text

Ungroup the character text string into several texts, each of which contains only one character.

3.9 Filling 

“ Filling ” is used for hatching a given graph. The graph to be hatched must be a closed curve.

The icon of “ Filling” in the Toolbar is [image: image47.png]


. When it is clicked, a dialog box will appear, as shown in Fig. 3-4.
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Fig. 3-4 “ Filling” Dialog Box
填充 Hatch
使能轮廓 Enable Contour
轮廓优先 Contour First
填充 Hatch
确定  OK
关闭  Close
保留填充对象的独立 Keep the Independence of Hatch Objects
使能 Enable
类型 Type
对象整体计算 Object Overall Calculation
绕边走一次 Go Around the Edge Once 

交叉填充 Cross Hatch 
快速填充 Fast Hatch
笔号 Pen Number
角度 Angle
线间距    0.06毫米  Line Spacing    0.06mm
数目      1  Quantity     1
平均分布填充线   Evenly Distributed Hatch Lines
边距      0毫米  Edge Distance      0mm
开始偏移  0毫米  Start Offset      0mm
结束偏移  0毫米  End Offset      0mm
直线缩进  0毫米  Linear Indentation      0mm
边界环数  0  Number of Boundary Rings  0
环间距    0.5毫米  Ring Spacing    0.5mm
自动旋转角度填充  Auto Rotation Angle Hatch
删除 Delete
删除时解散群组 Dismiss Group When Deleting
 Enabling Contour: Express whether to show and mark the contour of the original graph, namely, whether the Filling graph keeps the original contour.

Contour prior : Indicates that in the case of enabling contour, the contour is marked first and then the filling line is marked

Filling 1 / Filling 2 / Filling 3 / Filling 4: Four sets of unrelated filling parameters can be used for filling operation at the same time，It can achieve any angle of cross filling and each filling can support processing with five different filling types。（The four types of filling are: one-way filling, bow filling, circular filling, optimized two-way filling and two-way filling. See the following for details.）
Enable: determines whether to permit the validity of the current hatch parameter.

object overall calcul: serves as an optimized option. If it is selected, all the mutually exclusive objects will be calculated as a whole during hatch calculation, which will speed marking up on certain occasions. (If it is selected, the computer’s calculation may slow down), If it is not selected, each independent area will be calculated separately.

For ease of description, we now give a special example to illustrate this feature.

Draw three independent rectangles in the workspace, filling line distance is 1mm, angle is 0

1、Do not check "object overall calculation": the machining order in the object list will be followed during machining ，Mark the filling lines one by one, that is, mark the filling diagram of an object first and mark the next. as shown in Fig. 3-5:

[image: image49.jpg]



Fig.3-5 Do not check "object overall calculation"

2、Check "object overall calculation": mark all the filling lines in one time during machining, that is, mark the filling lines in the same line of several objects together. as shown in Fig. 3-6:

[image: image50.jpg]



Fig.3-6 Check "object overall calculation"

 Type filling：

[image: image51.png]


Unidirectional filling: Fill lines always fill from left to right. As shown on the left of figure 3-7.
[image: image52.png]


Bidirectional filling: Fill lines are filled from left to right, then right to left, and the rest are filled in cycles. As shown on the right of figure 3-7.

[image: image53.jpg]
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Fig.3-7 Left is Unidirectional filling，Right is Bidirectional  filling
[image: image55.png]


 Ring Hatch filling: the hatch lines will be marked from outside to inside of the object contour in a circular and skewing manner. 如图3-8左所示。

[image: image56.png]


 Ring filling: filling lines is object outline, from outside to inside cycle offset fill. As shown on the left of Figure 3-8.
[image: image57.png]


 Optimized bidirectional hatch: It is similar to bidirectional hatch, but the ends of hatch lines will connect. 如图3-8右所示。

[image: image58.png]


 Bow shaped filling: Similar to a two-way fill, but there are connecting lines between the ends of the fill lines. As shown on the right of Figure 3-8.

[image: image59.jpg]
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Fig.3-8 Left is Ring  filling, Right is Optimized bidirectional  filling
[image: image61.jpg]


 Optimization Gong type hatch: similar with Gong, will jump in null place. 如图3-9所示：

[image: image62.jpg]


 Optimized bow shaped filling: Be similar to bow shaped filling，It will still skip to fill in the blank space of the object. As shown in Figure 3-9:
[image: image63.jpg]



Fig.3-9  Optimized bow shaped filling
Those five types of hatch can be switched over by clicking the button [image: image64.png]


 with the mouse and can be set or modified conveniently and rapidly according to the required effects.

Angle: the angle between the hatch line and the X axis. 如图 3-10 所示为填充角度为 45 度时的填充图形。

Angle: Refers to the angle between the filling line and the X axis. As shown in Figure 3-10, it is a filling figure when the filling angle is 45 degrees.

[image: image65.jpg]



Fig. 3-10 Angle is 45 

Line Space: the space between two adjacent hatch lines.

Line margin: All fill calculations, Distance between filling line and profile object

[image: image66.jpg]
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Fig 3-11 Line Space
(the left figure is a fill figure with a fill margin of 0, and the right figure is a fill figure with a fill margin of 1)

Walk around：After filling calculation, add a contour around the periphery of the filling line

Average distrbutio：Solve the problem of uneven distribution of filling lines at the beginning and end of filling objects. Due to the size of the filled object and the setting of the fill line spacing， etc, After filling, there may be uneven distribution of filler lines at the beginning and end of the filled object.To simplify the operation, Without requiring the user to reset the line spacing,It can also achieve the goal of uniform distribution of all filling lines, Add this feature. After selecting this item, The software will automatically adjust the filling line spacing based on the spacing set by the user , To evenly distribute the filling lines

Start Offset: the distance between the first hatch line and the border of the object. 

End Offset : the distance between the last hatch line and the border of the object. 

 Straight: Refers to the reduction of both ends of the  fill line. A positive value indicates reduction and a negative value indicates extension. This function is used when the distances between both ends of the  fill line and the contour line are expected to be large during marking.

Boundary：Refers to the Before horizontal filling，Advanced ring filling. Due to the function of completely filling with rings, there will be cases where the last ring cannot be filled evenly,So this function is used to solve such problems.
[Note: the line space shall not be too large during text hatching, because a too large line space will cause the  filling effect to be invisible.]
Keep the independence：When multiple objects are filled together after checking, they are still multiple objects

Delete : Delete the object's fill line and restore the original content

Dismiss group on wher：Ungroup when you perform a delete operation.

Auto rotate filling: Check this item and set the rotation angle, then the angle of the filling line will be changed automatically according to the setting after each marking

Automatic rotation a

Multi-figure Operation: Default, Intersection, Union, Difference Set As shown in Figure 3-12, the figure combination can be filled with different patterns.
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Fig 3-12 The upper left is the default, the upper right is the intersection, the lower left is the union, and the lower right is the difference
4. Draw Menu

The “Draw Menu” is used for drawing various common shapes, including Point, Line, Curve, Polygon, etc. This menu has a corresponding Toolbar, and all related operations can be achieved through the icons in this Toolbar, as shown in Fig. 4-1. When you select a drawing command or the icon in the Toolbar, the Present Command Toolbar on the top of the workspace will be changed to show some options of the current command.
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        Fig a) “Draw” Menu                       Fig b) “Draw” Toolbar
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Fig c) Select the tools command bar
Fig4-1 “Draw” Operation
绘制 Draw 
修改 Modify
查看 View

点 Point
直线 Line
曲线 Curve
矩形 Rectangle
圆 Circle
椭圆 Ellipse

多边形 Polygon
文本 Text
图片文件 Image File
矢量文件 Vector File
延时器 Time-lapser
输入端口 Input Port
输出端口 Output Port
扩展轴 Extended Axis
编码器移动距离 Encoder Movement Distance
螺旋线 Helical Line
4.1. Point (P)

Drawing a point in the workspace is the simplest drawing operation. By selecting the “Point” command in the menu and clicking the left mouse button at an appropriate position in the workspace, you can draw a point at the position. Also you can draw more points by clicking the left mouse button continuously. After drawing, you can click the right mouse button to stop the point drawing command, and then the last point is displayed as the selected object.

4.2. Line (L)

To draw a line, the user can select the command “Line” in the Draw Menu or click the icon [image: image75.png]


, or click and move the left mouse button when the “Line" command is selected.
When the “Line” command is selected, input the coordinates of points directly by clicking the right mouse button, as shown in Fig. 4-2:

[image: image76.png]Input coordinates





Fig. 4-2 “Input Coordinates”
输入坐标 Input Coordinates
确定  OK
关闭  Close
4.3. Curve (S)

To draw a curve, the user can select the “Curve” command in the Draw Menu or click the icon [image: image77.png]


.

[image: image78.png]



Fig. 4-3 Curve Drawing
When the “Curve” command is selected, the user can draw curves freely by pressing the left mouse button and moving the mouse.

When the “Curve” command is selected, the user can move the mouse cursor to the beginning node of the curve and press the left mouse button to close the current curve automatically.

4.4. Rectangle(R)

To draw a rectangle, the user can select the “Rectangle” command in the Draw Menu or click the icon.

When the “Rectangle” command is selected, the user can press the left mouse button and move it to draw a rectangle.

When the “Rectangle” command is selected, the user can draw a square by pressing the left mouse button and the “Ctrl” key simultaneously and moving the mouse.

When a rectangle is selected, the rectangle properties as shown in Fig. 4-4 will be displayed in the Properties Toolbar.
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Fig. 4-4 Rectangle Properties Toolbar
对象属性栏 Object Property Bar

位置 Location
尺寸 Size
阵列 Array
应用 Apply
圆角程度 Fillet Degree
所有边圆角 All Edge Fillet
Degree of fillet: It refers to the roundness of the rectangle’s four corners. If the roundness is 100%, the corner turns into an arc.
All Corners Round: When it is activated, the user can modify the roundness of the four corners by just modifying one of them.
NOTE: Whenever the parameters in the Properties Toolbar are modified, it is a must to click the “Apply” button to effect the modification, which applies to the following operations.
4.5. Circle (C)

To draw a circle, the user can select the “Circle” command in the Draw Menu or click the icon[image: image80.png]


.

When the “Circle” command is selected, the user can press the left mouse button and move the mouse to draw a circle.

When a circle is selected, the circle properties as shown in Fig. 4-5 will be displayed in the Properties Toolbar.
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Fig. 4-5 Circle Properties Toolbar
对象属性栏 Object Property Bar

位置 Location
尺寸 Size
阵列 Array
应用 Apply

半径 Eadius
开始角度 Start Angle
Circle Diameter: the diameter of a circle.

Starting Angle: the angle of the starting point of a circle relative to its center.

[image: image82.jpg]


: It means the current circle is marked clockwise.
[image: image83.jpg]


: It means the current circle is marked anticlockwise.
4.6. Ellipse (E)

To draw an ellipse, the user can select the “Ellipse” command in the Draw Menu or click the icon[image: image84.png]


.

When the “Ellipse” command is selected, the user can press the left mouse button and move the mouse to draw an ellipse.

When the “Ellipse” command is selected, the users can draw a circle by pressing the left mouse button and the “Ctrl” key simultaneously and moving the mouse. 

When an ellipse is selected, the ellipse properties as shown in Fig. 4-6 will be displayed in the Properties Toolbar.
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Fig. 4-6 Ellipse Properties Toolbar
对象属性栏 Object Property Bar

位置 Location
尺寸 Size
阵列 Array
应用 Apply

开始角度 Start Angle

结束角度 End Angle
Starting Angle: the angle of the starting point of an ellipse relative to its center.
End Angle: the angle of the ending point of an ellipse relative to its center.
[image: image86.jpg]


: It means the current ellipse is marked clockwise.
[image: image87.jpg]


: It means the current ellipse is marked anticlockwise.
4.7. Polygon (M)

To draw a polygon, the user can select the “Polygon” command in the Draw Menu or click the icon [image: image88.png]


.

When the “Polygon” command is selected, the user can press the left mouse button and move the mouse to draw a polygon. 

When a polygon is selected, the polygon properties as shown in Fig. 4-7 will be displayed in the Properties Toolbar.
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Fig. 4-7 Polygon Properties Toolbar
Edge Num.: It refers to the number of a polygon’s edges with the minimum number of three.
对象属性栏 Object Property Bar

位置 Location
尺寸 Size
阵列 Array
应用 Apply

边数 Number of Edges
4.8. Text (F)

Inputting characters directly in the workspace is supported in SeaCAD, and the fonts include all those supported by the system and many others set in the SeaCAD. To input characters, the user can select the “Text” command in the Draw Menu or click the icon [image: image90.png]


.

When the “Text” command is selected, the user can create text objects by clicking the left mouse button.
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Fig. 4-8 Text Properties Toolbar

位置 Location
尺寸 Size
阵列 Array
应用 Apply

字体 TrueTypez字体  Font  TrueTypez Font
自动  Auto
边距  Edge Distance
中心距  Center Distance
1毫米  1mm
高度  10.000毫米  Height  10.000mm
使能变量文本  Enable Variable Text
If you need to modify the text, you can directly modify it in the text edit box.

SeaCAD supports four types of fonts (TrueType fonts, single line fonts, barcode fonts, bitmap fonts) and other fonts that are installed independently.

After selecting the font type, the font list will list all fonts of the current type accordingly, as shown in Figure 4-9 is a TrueType font list.
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Fig. 4-9 TrueType List

Height: The average height of the font.
字体 TrueTypez字体  Font  TrueTypez Font

方正舒体 FZShuTi 

方正姚体 FZYaoTi 

仿宋  Fangsong
黑体  Black Body

华文彩云  STCaiyun 

华文仿宋  STFangsong 

华文行楷  STXingkai
华文琥珀  STHupo
华文楷体  STKaiti 

华文隶书  STLiti 

华文宋体  STSong
华文细黑  STXihei
华文新魏  STXinwei
华文中宋  STZhongsong 

楷体  Regular Script
隶书  Clerical Script
宋体  SimSun
微软雅黑  Microsoft YaHei 

新宋体  NSimSun 

幼圆  Simyou
4.8.1. Font Parameters

点击[image: image93.png]


后系统弹出如图4-10所示对话框。
After clicking [image: image94.png]


, the system pops up the dialog box shown in Figure 4-10.
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Fig. 4-10 Font Properties
字体  Fonts
对齐方式  Alignment
左  Left
中  Center
右  Right
粗体 Bold
斜体 Italic
排列方向  Sorting Direction
水平  Horizontal
垂直  Vertical
使能等宽字符  Enable the Same Width Character
字符宽度   45.80% 字符高度    

Character Width   45.80%  Character Height
字符角度   0度（-89,89）   Character Angle   0 degree (-89,89)
字符间距   0mm   Character Spacing   0mm
行间距   0mm   Line Spacing   0mm
使能文本总宽度  Enable Total Text Width
文本总宽度  20mm   Total Text Width  20mm
圆弧文本    Circle Text
圆直径   50  Circle Diameter   50  
基准角度   90   Base Angle   90   
文字反排  Text Reverse
文字倒立  Text Invert
文本位于圆弧内侧  Text Inside the Arc
角度范围控制  90  （1-360）   Angle Range Limit   90  (1-360)
应用  Apply
确定  OK
关闭  Close
Alignment: “Left”, “in” and “Right” mean that the current text is aligned to the left/center/right respectively.
Bold: When selected, the current text become bold.
Italic: When selected, the current text become italic
 Arrange direction: Horizontal means Horizontal arrangement, Vertical means vertical arrangement.

Enable the Same Width Character: make all characters keep the same width.
Char Width: the average width of characters.
Char Angle: the angle of inclination of characters.
Char Space: the distance between characters.
Line Space: the distance between two rows of characters.
Circle Text: 选择[image: image96.jpg]I~ BB



, the text will align according to the user definition circle diameter. As show in figure 4-11. 

Arc Text: Select the [image: image97.png]Arc text




 circle text, the text will align according to the user definition circle diameter. As show in figure 4-11. 

[image: image98.jpg]




Fig. 4-12 Path Circle Text
Circle Round：diameter of circle text。

Reference Angle: the angle benchmark for text alignment. Starting datum with the leftmost angle of the text. As show in figure 4-12.
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fig 4-12 left side is the reference angle = 0, right is the reference angle = 90

Angle Range Limit: When it is selected, the text will be limited in the angle range limit no matter how many characters are input.as shown in Fig. 4-13:
[image: image101.jpg]
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Fig. 4-13 Left one is click Angle Range limit，On the right, there is no check angle range limit。
长沙八思量信息技术有限公司

Changsha SeaThinking Info. Tech. Co., Ltd.

长沙八思量信息技术有限公司

Changsha SeaThinking Info. Tech. Co., Ltd.

Inverse text：Reverse the text.as shown in Fig:

[image: image103.jpg]



Text handstand: Arrange text upside down. The following picture:

                      [image: image104.jpg]@@ {V ,,,,,,




   he text is located inside the arc: Place the text on the inside of the arc, following figure
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Fig. 4-16 The text is located inside the arc
路径文本  Path Text
基准角度  Base Angle
角度范围  Angle Range
文字反排  Text Reverse
文字顶端对齐  Text Top Alignment
文本位于圆弧内侧  Text Inside the Arc
确定  OK
关闭  Close
4.8.2. Barcode Font Parameters

当在字体里面选择条形码字体后[image: image107.jpg]F



，点击按钮[image: image108.png]


后系统弹出如图4-19所示对话框。

After selecting the barcode font [image: image109.png]Font  Barcode font



 in the fonts, click the button barcode [image: image110.png]


 and the system will pop up a dialog box as shown in Figure 4-19.
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Fig. 4-19 Dialog Box of Barcode Font Parameters

条形码  Barcode
39条码是条空均表示信息的非连续型，非固定长度的双向条码；它的字符集包含‘0’-‘9’，‘A’-‘Z’空格，‘$’，‘%’，‘+’，‘-’，‘.’，‘/’；有可选的校验码，校验码由系统自动加入。

The 39 barcode is a two-way barcode with non-continuous and non-fixed length that represents information by bars and spaces; its character set contains ‘0’-’9’, ’A’-’Z’ spaces, ’$’, ’%’, ’+’, ’-’, ’.’, and ‘/’ ; there are optional check codes, which are automatically added by the system.
文本  Text
显示文本  Display Text
黑白反转  Black and White Invert
空白  Blank
顶部  Top
左边  Left
右边  Right
底部  Bottom

字体  Arial    Font  Arial

文本高度  2毫米    Text Height  2mm
文本宽度  1.5毫米   Text Width  1.5mm

文本X偏移  0毫米   Text X Offset   0mm
文本Y偏移  0毫米   Text Y Offset   0mm
文本间距   0毫米    Text Spacing   0mm
高度  24.5毫米    Height   24.5mm

标准模块高度  0.33毫米    Standard Module Height   0.33mm
固定尺寸  Fixed Size
比例  Scale
空  Space
条  Bar
确定  OK
关闭  Close
 Display Text: determines whether to show a corresponding text for identification under the barcode.
Pen No：Select the pen number for the text, the default is the same as the barcode.
Font: the font of the current text to be displayed.
Text Height: the average height of the text.
Text Width: the average width of the text.
Text X Offset: the coordinates of text offset in the direction of X axis.
Text Y Offset: the coordinates of text offset in the direction of Y axis.
Text spacing: the space between characters.
4.8.2.1. One-Dimensional Barcode
It consists of “strip” and “space” arranged one by one. The barcode information is carried by different widths and positions of bar and space, and the information volume is decided by the width and the precision of barcode. The wider the barcode is, the more bars and spaces are included, and the more information is carried. This kind of barcode technology can store information in only one direction through permutation and combination of bars and the spaces, so it is called one-dimensional barcode. Fig. 4-20 shows the parameter setting in the window when a one-dimensional barcode is selected.
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Fig. 4-20 One-dimensional Barcode Parameters
黑白反转  Black and white Invert
空白  Blank
顶部  Top
左边  Left
右边  Right
底部  Bottom

条码高度  16.170毫米    Barcode Height  16.170mm
标准模块宽度  4.53883毫米   Standard Module Width  4.53883mm

比例  Scale
条  Bar
空  Space
Black and White  Reversa: determines whether to invert the marking. This function is used for some materials which are light-colored after marking.
Blank：When the barcode is reversed, you can specify the size of the blank area around the barcode.

 Barcode Height: the height of the barcode.
Standard Width:Refers to the width of the narrowest strip module, that is, the width of the reference strip module. Commonly a one-dimensional barcode consists of bars and spaces with four types of width respectively, and 1, 2, 3 and 4 refer to 1, 2, 3 and 4 times the width of the unit bar as per the width size of bars and spaces. The width of the narrow bar means the width of one unit bar.

The actual width of Bar 2 is a scale of the narrow bar width multiplied by the width of Bar 2, and the method applies for Bar 3 and 4.
The actual width of Space 1 is a scale of the narrow bar width multiplied by the width of Space 1, and the method applies for Space 2, 3 and 4.
Blank：A limited area with the same reflectivity as the space on the outside or in the middle of the left and right ends of the barcode，The actual width of the blank area is equal to the width of the narrow strip module multiplied by the proportion of the blank.

4.8.2.2. Two-Dimensional Barcode
4.8.2.2.1. PDF417 Barcode
PDF is the acronym of the three words "Portable Data File", meaning "Portable Data File". Figure 4-21 is the demonstration of PDF417 Barcode. Figure 4-21 is the demonstration of PDF417 Barcode. 

Bar code Height: the height of the barcode
Module width: Refers to the width of the narrowest bar module.

 Error correction：the Error-Checking Level of PDF417 barcode, from 0 to 8.

Lines and Columns: the lines and Columns of PDF417 barcode.
[image: image113.png]



Fig. 4-21 PDF417 Barcode
4.8.2.2.2. DataMatrix Barcode
DataMatrix is a kind of two-dimensional barcode based on Matrix, as shown in Fig. 4-22:

Data Matrix has various fixed size, and users can choose what they want have. If the smallest size is chosen [image: image114.png]matix
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，the system will automatically select the smallest frame to fit the all text users

Data Matrix has various fixed size, and users can choose what they want have. If the smallest size is chosen [image: image115.jpg]L EN P2 X
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，the system will automatically select the smallest frame to fit the all text users
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Fig. 4-22 DataMatrix Barcode
4.8.2.2.3. QR-Code
QR-Code Barcode is a kind of two-dimensional barcode and its character set includes all ASCII values, as shown in Fig. 4-23:
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Fig. 4-23 QR-Code Barcode and QR code parameter setting
条形码  Barcode
文本  Text
显示文本  Display Text
笔号  0  Pen Number  0
字体  Arial  Font  Arial
文本高度 3毫米  Text Height  3mm
文本宽度 1.5毫米  Text Width  1.5mm
文本X偏移  0毫米   Text X Offset   0mm
文本Y偏移  0毫米   Text Y Offset   0mm
文本间距   0毫米    Text Spacing   0mm
自定义显示文本  Custom Display Text
（#字符 ?删除 %效验 /换行）  (#Character ?Delete %Validation /Newline)
点模式  Dot Mode
圆模式  Circle Mode
矩形模式  Rectangle Mode
小图形宽度占比50%  Small Graph Width Accounts for 50%

黑白反转  Black and White Invert
空白  Blank
顶部  Top
左边  Left
右边  Right
底部  Bottom

标准模块宽度  0.33毫米    Standard Module Width   0.33mm
固定尺寸  Fixed Size
比例  Scale
条  Bar
空  Space

矩阵   默认   Matrix   Default
纠错级别   L  Error Correction Level  L
中心留白  Center Blank
留白比例：15%  Blank Scale: 15%
确定  OK
关闭  Close
显示文本：显示文本下的功能同条形码属性的文本功能。
Display Text: The function under the display text is the same as the text function of the barcode properties.
Custom display text：User can use commands to display the text you want to display. #- represents the character that shows the current position,? - represents the character that deletes the current position, %- represents the position number of the character that displays the current position, and -/ is a line-up display character string. For example:
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条码  Barcode
自定义显示文本  Custom Display Text
（#字符 ?删除 %效验 /换行）  (#Character ?Delete %Validation /Newline)
 point Mode, Round Mode, and Rectangle Mode: Select the mode that makes up the two-dimensional code. The examples are as follows (from left to right,  point mode, circle Round mode, rectangle mode):
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The proportion of graphics width：Set the size of the element which formed two-dimensional code. The adjustment range is from 1 to 100. It is valid only for the circle mode and rectangle mode.

Fixed size：Set the size of the two-dimensional code.

Center blank：An area will be vacated in the center area of the QR code , which will be used to place company LOGO, pictures, etc.

4.8.3. Variable Text

The Enable Variable Text will be available after the [image: image123.png]Enable variable text




Enable Variable Text is selected, and the variable text properties as shown in Fig. 4-24 will be displayed by the system. The “Variable Text” means that a text can be modified dynamically based on the rules given by the user during marking.
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Fig. 4-24 Variable Text Properties
自动  Auto
边距  Edge Distance
中心距  Center Distance

1毫米   1mm

使能变量文本  Enable Variable Text
Auto: Automatically sets the distance between characters.
Margin: It refers to the distance from the right boundary of left character to the left boundary of right character.as shown in Fig. 4-25:
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Fig.4-25 Spacing Margin
字符间距   Character Spacing 
Center Distance: The calculation of character spacing refers to the distance between the left character center and the right character center. as shown in Fig. 4-26:

[image: image126.png]



字符中心距  Character Center Distance
Fig.4-26 Center Distance
The user may add various variable text elements as required and sequence the text elements. After the “Add Text Element” is selected, the dialog box as shown in Fig. 4-27 will pop out.
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Fig. 4-27 Text Element Dialog Box
文本元素  Text Elements
元素类型  Element Type
固定文本  Fixed Text
序列号  Serial Number

日期  Date
时间  Time 

网络通讯  TCP/IP Communication 

串口通讯  Serial Communication
SQL数据库  SQL Database 

文件  File
键盘  Keyboard
实时TXT文本   Real-time TXT Text
实时Excel文本  Real-time Excel Text
不使用前导零  Leading Zero Before Disuse
文本  Text 

文本类型  Text Type
文本  Text
换行符  Newline Character
用户名  Username
Fixed Text: It refers to the invariable element in the text during marking.
Serial Number: It refers to the element changing with the fixed increment during marking.
Date Code: The system will automatically read date information from the computer during marking.
Time: The system will automatically read time information from the computer during marking.
Network Communication: During the processing, the system reads the elements of the text to be processed through the network

Serial Communication: The system will read the text to be marked through the serial port during marking.
SQL Database: The system will automatically read the text to be marked from the connected database during marking.
File: Text to be processed are read directly from the "TXT" "EXCEL" file.
Keyboard: The elements of the text to be processed are entered by the user from the keyboard during processing.
4.8.4.1. Fixed Text Element
It refers to the invariable element during marking.
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Fig.4-28 Fixed Text Element
文本元素  Text Elements
元素类型  Element Type
固定文本  Fixed Text
序列号  Serial Number

日期  Date
时间  Time 

网络通讯  TCP/IP Communication 

串口通讯  Serial Communication
SQL数据库  SQL Database 

文件  File
键盘  Keyboard
实时TXT文本   Real-time TXT Text
实时Excel文本  Real-time Excel Text
不使用前导零  Leading Zero Before Disuse
文本  Text 

文本类型  Text Type
文本  Text
换行符  Newline Character
用户名  Username
Newline character: Applied to the variable text function to solve the problem of multiple lines that require branch marking. When applied, a new line character is added between the two texts, and the software automatically branches the text according to the position of the newline character. If multiple texts need to be split into multiple lines, simply add a line break after the text to be split
Username: When this option is selected, the system automatically replaces the current user name using SeaCAD with a fixed text.
4.8.4.2. Serial Number Element
The serial number element is a text element which changes with the fixed increment during marking.

When the Serial Number is selected, the serial number parameter definition will automatically be displayed in the text element dialog box, as shown in Fig. 4-29.
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Fig.4-29 Serial Number Element
文本  Text 
开始序号  Start Serial Number
当前序号  Current Serial Number
最终序号  Final Serial Number
序号增量  Serial Number Increment
每个标刻数   Number of Every Marking
模式  Mode 
复位  Reset
整点复位  Integral Point Reset
不循环打标  Non-Circular Marking 
当前标刻数  Number of Current Marking
十进制  Decimal System
设置  Setting
过滤以下序号  Filter the Following Serial Number 

确定  OK 

关闭  Close
Start SN: the first serial number to be marked at the moment.
Current SN: the serial number to be marked at present.
Final SN: When it comes to the marking of limit serial number, the system will return to the start serial number automatically.
Serial: It refers to the increment of the current serial number. When set as a negative value, the serial number will decrease progressively.
When the increment of the current serial number is 1, and the start serial number is 0000, each number will be added with 1 based on its previous number, for example, 0000, 0001, 0002, 0003 … 9997, 9998, 9999. When it comes to 9999, the system will return to 0000 automatically.

When the increment of the current serial number is 5, and the start serial number is 0000, the serial numbers are: 0000, 0005, 0010, 0015, 0020, 0025…..and so forth.
Each Marks：It means that the serial number will not be changed until the specified number is processed for each serial number. Then, after machining to the specified number, the serial number is changed again to cycle.
Current Marks.: It means that the serial number will not be changed until the specified number is processed for each serial number。Then, after machining to the specified number, the serial number is changed again to cycle.
Mode: the carry mode of the current serial number.
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: The system will filter out serial numbers whose certain digit is a particular value after it is selected. The [image: image131.jpg]


 means that the serial numbers with 4 as the tail number will be filtered out, and the * can be numbers with any digits.
Reset: You can customize the reset time or reset every point. Every day this time, the serial number of the mark changes to the start sequence number.
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：Stop the marking task after you finish the Specified sequence number。

4.8.4.3. Date Code
Date element: The system will automatically read date information from the computer during marking.
When the Date element is selected, the date parameter definition will be displayed in the text element dialog box automatically, as shown in Fig. 4-22.
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Fig. 4-22 Data element Parameter Definition
文本  Text 
自定义  Custom
年-2019  Year-2019 

年-19  Year-19 

年-9  Year-9  

月-12  Month-12 

日-5  Date-5 
天-339  Day-339 

星期-04  Day of Week-04 

星期-4  Day of Week-4 

周-49  Week of Year-49
日期偏移  Date Offset 

按年  Per Annum
确定  OK 

关闭  Close
Year-2020: takes the year indicated by the current computer clock as the corresponding text with four characters.
Year-20: takes the year indicated by the current computer clock as the corresponding text with two characters: only the latter two digits are taken.
Month-02: takes the month indicated by the current computer clock as the corresponding text with two characters.
Day-07: takes the date of each month indicated by the current computer clock as the corresponding text with two characters.
Day-038: takes the number of days from January 1 to the date indicated by the current computer clock as the corresponding text with three characters. (001 represents January 1, 002 represents January 2, and so on).
Day of Week-05: takes the day of week indicated by the current computer clock as the corresponding text with two characters.
Week of Year-5: takes the week of year of the date indicated by the current computer clock as the corresponding text with two characters (take the period from January 1 to the first Saturday as the first week).
Date Offset: When the system reads the date indicated by the computer clock, it is necessary to add the set offset-date to obtain the marking date. This function is mainly used for the marking of workpieces with production date and shelf life in food industry and the like.
自定义：自己定义年份的显示内容。

Custom: Define the display content of the year by yourself.

4.8.4.4. Time Element 

Time Element is system will automatically read time information from the computer during marking.
When the Time Element is selected, the time parameter definition will automatically be displayed in the text element dialog box, as shown in Fig. 4-23.
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Fig. 4-23 Definition Time Parameter 
文本  Text
小时-24  Hour-24
小时-12  Hour-12
分钟  Minute
秒  Second
时间段  Time Section
Hour-24: takes the time in hour indicated by the current computer clock as the corresponding text in the 24-hour time system.
Hour-12: takes the time in hour indicated by the current computer clock as the corresponding text in the 12-hour time system.
Minute: takes the time in minute indicated by the current computer clock as the corresponding text.

Second: takes the time in second indicated by the current computer clock as the corresponding text.

 Period: 24 hours of one day are divided into 24 time sections, and the user can define a text for each time section. This function is mainly used for the marking of workpieces requiring the shift information.

4.8.4.5. Network communication
The network communication element is the element that the system automatically reads the text from the network through the computer network interface during the processing
Notice: The network interface in here is the network interface uses in TCP/IP agreement. When the user selected the “TCP/IP communication”, the parameter defines will display automatically in the dialog box, see the figure 4-24: 
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Fig.4-24  Network communication elements
文本元素  Text Elements
元素类型  Element Type
固定文本  Fixed Text
序列号  Serial Number

日期  Date
时间  Time 

网络通讯  TCP/IP Communication 

串口通讯  Serial Communication
SQL数据库  SQL Database 

文件  File
键盘  Keyboard
实时TXT文本   Real-time TXT Text
实时Excel文本  Real-time Excel Text
不使用前导零  Leading Zero Before Disuse

文本  Text
IP地址  IP Address
端口号  Port Number
打标  Marking
超时设置  Timeout Setting
连接超时  Connect Timeout
接收超时  Receive Timeout
确定  OK 

关闭  Close
IP Address: select the IP address which from reads the data
Port : select the port the TCP/IP communication used
Command: When the system processes to this text object, the system through the network interface to transmit this order character string to a computer assigned the IP address, request the computer sends the character string needs to process at present, the system will not return until the computer replied, after the response of the computer, the system will process the returns text automatically.

Unicode: After choosing this option, the system to the computer transmission which and the read character is the Unicode form, otherwise is the ASCII form. 

Timeout setting: You can set the timeout period for connecting the specified IP address and receiving data.

4.8.4.6. Serial communication
The serial communication element is the element that the system automatically reads the text from the peripheral device through the computer serial port during the processing，When the user selects the serial communication element, the parameter definition of the serial communication element will be automatically displayed in the text element dialog box。As shown in Figure 4-25.
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Fig.4-25 Serial communication
文本元素  Text Elements
元素类型  Element Type
固定文本  Fixed Text
序列号  Serial Number

日期  Date
时间  Time 

网络通讯  TCP/IP Communication 

串口通讯  Serial Communication
SQL数据库  SQL Database 

文件  File
键盘  Keyboard
文本  Text
端口号  Port Number
波特率  Baud Rate
数据位  Data Bits
停止位  Stop Bits
奇偶校验  Parity
打标文件  Marking Document

只显示部分数据  Display Part of Data
加换行符  Add Newline
第1位到第2位（右起）  1st to 2nd (From Right)
确定  OK 

关闭  Close
Port: the port which computer and peripheral equipment connection used
Baud Rate: Baud Rate which the serial communication used
Data Bits: Data Bits which the serial communication used
Stop Bits: the digits of Stop Bits of which the serial communication used
Parity: select the digits of Parity which the serial communication used
Command: When the system processes this text object, the system will send this command string to the external device through the current serial port，Request the external device to send the current string to be processed,The system will wait for the external device to answer before returning,After the external device answers, the system will automatically process the returned text.
Show only partial data: check to show characters between specified bits

4.8.4.7. File element

TXT: When TXT is selected, the content shown in Figure 4-26 will be displayed. The user is required to set the line number of the associated file and the current text to be processed

Automatic reset: When the processing reaches the end of the text file, the line number is reset to 0, and the processing starts again from the first line.

Read the entire file: When processes to the text document direct read entire Document.
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Fig.4-26 TXT
文本  Text
文件名称  File Name
行号  Line Number
增量  Increment
自动复位  Auto Reset
每次读整个文件  Read the Entire File at a Time
EXCEL：When the excel file system is selected, the content shown in Figure 4-27 will be displayed. The user is required to set the file name, field name and line number of the current text to be processed.

Field name: The text of the first row of all columns of form 1 in the excel file table. During processing, the system will automatically take out the text to be processed from the corresponding column.
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Fig. 4-27 EXCEL
文本  Text
文件名称  File Name
行号  Line Number
增量  Increment
字段名称  Field Name
自动复位  Auto Reset
4.8.4.8. Keyboard
The keyboard element is the text which must process from the keyboard entry by the user, when select the keyboard element, a dialog box as Figure 4-47 shows will be displayed to ask for the user set the keyboard element parameter. Tips In the process of processing, when the system encounters the text of keyboard variables, it will pop up the content in the input dialog box, requiring the user to enter the text to be processed, at this time, the user directly enters the text to be processed manually.
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Fig.4-28 Keyboard
文本  Text
提示  Tip
请输入要加工的文本  Please enter the text to be processed
固定字符数  Fixed Character Count
设置笔参数  Set Pen Parameters
输入端口  Input Port
Fixed Number: user must input string with digit equals to this count.
Set Pen Param: The keyboard can be used to directly read the processing parameters of speed, power and frequency, Set pen 0.power to indicate the power of pen 0, pen 1.speed to indicate the speed of pen 1, pen 2.freq to indicate the frequency of pen 2, and set according to this rule.


The keyboard element function uses frequently in this kind of situation when the processing needs the real-time input to the processing content. If the customer present need processes one batch of work pieces, on each work piece is printed with a bar code, when processing needs the user with the bar code scanning gun real-time scans the work piece to read the content on the bar code, then with laser to mark to the work piece assigns in the position, at this time can use the keyboard element function. At the processing time system springs like the figure 4-30 shows the dialog box, the operator with the bar code scanning gun scanning bar code work piece on, the bar code scanning gun inputs the read content to the dialog box inside and closes it automatically, then the system will start to process the content read a moment ago automatically . 
4.8.4.9. Advance Function

After selecting advanced functions, the system will pop up a dialog box as shown in Figure 4-29.
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Fig.4-29 Advance Function

高级  Advance
使能分割字符串修改指定名称的文本对象  

Text Object that Enables Split Strings to Modify the Specified Name  
标刻自己  Mark Self
使能固定文本宽度 10.000mm  Enable Fixed Text Width  10.000mm
增加  Add
删除  Delete
修改  Modify 
确定  OK 

关闭  Close
Mark yourself: In certain situations, when the user needs to split the variable text and then mark them in different positions, and also needs to mark the variable text, this function is applicable. It is conducted by setting the parameters for character splitting and selecting “Mark Self”. During marking, besides the split character, all input variable texts will be marked in corresponding positions.

使能固定文本宽度：设置文本的固定长度，不管内容多少长度是固定的。

Enable Fixed Text Width: Set the fixed length of the text, and the length is fixed no matter how much the content.
Select “Enable Split String to modify text object the”, and click “Add” button to get the dialog box as shown in Fig. 4-30.
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Fig.4-30 Advance Function

参数  Parameters
在字符串中第一个字符的位置  Location of the First Character in String
从字符串中提取的字符总个数  

Total Number of Characters Extracted From the String
想要修改字符内容的文本对象名称  

The Name of the Text Object that You Want to Modify the Character Content  
确定  OK 

关闭  Close
The position of the first character in the string: The starting character in text1 text is the number of characters in the string of variable text.

The total number of characters extracted: Extract several characters from the string of variable text from the first character set.

The Name of Text Entity Which You Want to Change: When it is selected, it is necessary to input the name of a fixed text for the character to be split and read.
The text object name for which you want to: Enter the name of the fixed text that you want to modify for the characters read by the partition.
Add Char Mode: when it is selected, the split and read character will be added to the position following the fixed text. 

For example:
Create a new variable text (take a variable serial number text as an example)
Click “Advance” in the Variable Text Properties Toolbar, and select “Enable Split String to Change Other Text Entity”, as shown in the following figure:
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Fig.4-31
高级  Advance
使能分割字符串修改指定名称的文本对象  

Text Object that Enables Split Strings to Modify the Specified Name  
标刻自己  Mark Self
使能固定文本宽度10.000mm  Enable Fixed Text Width 10.000mm
增加  Add
删除  Delete
修改  Modify 
确定  OK 

关闭  Close

When “Add” is clicked, the following dialog box will pop out (it means that two characters starting from the first character in the variable text are extracted to replace the content in the fixed text entity with an indicated name) [image: image143.png]Config
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Fig.4-32
参数  Parameters
在字符串中第一个字符的位置  Location of the First Character in String
从字符串中提取的字符总个数  

Total Number of Characters Extracted From the String
想要修改字符内容的文本对象名称  

The Name of the Text Object that You Want to Modify the Character Content  
确定  OK 

关闭  Close
After confirmation, draw a fixed text object, and change the name of the text object to the name set by the above rule
4.9.   Draw Picture file
4.9.1.  Input Bitmap
To add a bitmap, the user can select the “Bitmap” command in the Draw Menu or click the icon [image: image144.png]


.
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Fig. 4-33 Bitmap Inputting Window
The system will pop up the input dialog box as shown in Figure 4-33 and ask the user to select the bitmap to be input. The currently supported bitmap formats are: Bmp; Jpeg, jpg; Gif; Png; Tiff; Tif; Emf. The system will automatically display the picure of the current file in the preview box, and will also put the center of the current picture on the origin of the coordinates.

After entering the bitmap, the property toolbar displays the bitmap parameters as shown in Figure 4-34.
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Fig.4-34 Bitmap parameters
4.9.2.  Reversal
Reversal: The color value of each point in the current picture is reversed, and the formula adopted is PX new = 255 – PX old, as shown in Figure 4-35.
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Fig. 4-35  Reversal Image
4.9.3. GrayScal
changes a color image into a 256-level grey scale image, as shown in Fig. 4-36. In the state of gray-scale image, the contrast and brightness of the image can be adjusted to achieve better marking effect.
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Fig. 4-36  Image gray processing example
4.9.4. Fixed DPI
The concept of DPI is the number of pixels per inch, one inch equals 25.4mm. When the DPI value is higher, the image printing is clearer and the processing time is longer. Otherwise, the more blurred, the processing time is shorter. You can use the default DPI value without fixing the DPI.

4.9.5. Outlets
Outlets: Dot representation is similar to the "halftone pattern" function in Adobe Photoshop. Black and white dichroic images are used to simulate gray-scale images, and black and white dichroic images are used to simulate different gray-scale effects by adjusting the density of points, as shown in figure 4-37.
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Fig.4-37 Dither Outlets
4.9.6.  Two-way scanning
The scanning is bidirectional during the marking of bitmaps. 该方法可以提高一定打标速度。

The scanning is bidirectional during the marking of bitmaps. This method can improve a certain marking speed.
4.9.7.  Dotting Time
Dotting Time: The time it takes for the laser to dot each pixel. This value can be modified to adjust the bitmap marking speed under the dotting mode.
4.9.8.   Dot Power Mapping
不同像素点映射不同的打点功率。界面中的最大值是设置最大功率，点击最大值，再按复位，则生成新的映射表；同理可以设定最小值，或者设定特定的值。设定之后，按复位键重新生成映射表。效果如图4-38所示。

Different pixel mapping different power，The maximum value in the interface is to set the maximum power. Click the maximum value and then press reset to generate a new mapping table; similarly, you can set the minimum value or set a specific value. After setting, press the reset button to regenerate the mapping table. The effect is shown in Figure 4-38.
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图4-38 点功率映射

Figure 4-38 Dot Power Mapping 

功率映射  Power Mapping
灰度  Grey Scale
功率%  Power% 

确定 OK 

取消  Cancel 

生成  Generate 

最大值  Maximum Value 

最小值  Minimum Value 

修改  Modify
4.9.9. Expand Parameter
Expand Parameter: Figure 4-39.
Y direction scanning: Set y-scan, the printing direction will be changed to y-scan.
Bitmap scan increment: When there are many image pixels or large image area, printing is time-consuming. You can scan additional lines, skip several lines for printing, but the printing effect will be reduced.
A point below the pixel value: Set the pixel point below which pixels will not be marked.
Point interlaced dislocation: In even rows, the first pixel is removed, and each pixel in the remaining rows moves forward one pixel in turn.
Optimize Mode: calculate the marking speed according to the DPI and frequency to optimize marking speed and result.
加速距离和减速距离：控制打标及其的移动加速参数。

Acceleration Distance and Deceleration Distance: Control the marking and its movement acceleration parameters.
整体偏移和双向偏移：控制打标图片的X，Y两个方向的移动量。

Overall migration and Bi-directional: Control the amount of movement in the X and Y directions of the marking images. 
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Fig.4-39 Expand Parameter
位图  Bitmap
Y向扫描  Y Direction Scanning
位图扫描行增量  Bitmap Scanning Line Increment
不刻标低于像素值的点  Do Not Mark Points Below the Pixel Value
点隔行错位  Point Interlacing Dislocation
优化模式  Optimization Mode
加速距离  0毫米  Acceleration Distance  0mm 
减速距离  0毫米  Deceleration Distance  0mm
整体偏移  0毫米  Overall Offset  0mm 
双向偏移  0毫米  Bidirectional Offset  0mm
确定  OK 

取消  Cancel

图

4.10. Draw Vector File
To input a vector file, the user can select the “Vector File” command in the Draw Menu or click the icon [image: image153.png]


.
The bitmap formats supported by the current system include AI, PLT and DXF. The Fig. 4-40 shows the result of vector image import.
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Fig. 4-40 Vector Image Import
4.11.   Draw delay
If you want to enter a delayer control object, Choose the time delay command from the draw menu or click the icon.

When the “Delayer” is selected, the delayer property as shown in Fig. 4-41 will be displayed in the Properties Toolbar.
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Fig. 4-41 Delayer Property
等待时间  10毫秒    Waiting Time  10 ms
Waiting time: When the marking comes to the current delayer, the system will wait for a scheduled period and then continue to operate.
4.12. Draw Input Port
To input the control object of input port, the user can select the “Input Port” command in the Draw Menu or click the icon [image: image156.png]=



.
After the “Input Port” is selected, the input port properties as shown in Fig. 4-42 will be displayed in the Properties Toolbar.
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图4-42 输入口参数

Figure 4-42 Input Port Parameters

I/O控制条件  I/O Control Condition
提示消息  Prompting Message
使能  Enable
I/O Control Condition: When the marking comes to the current input port, the system will read the input port and compare the read value with the I/O Control Condition; if the two equal, the system will proceed to the following ports, and otherwise it will read the port again.
Prompt Message: It is given by the system when it reads the port repeatedly and waits for the matching between the port value and the I/O Control Condition.
4.13. Draw Output Port
To draw the control object of output port, the user can select the "Output Port” command in the Draw Menu or click the icon [image: image158.png]


.
After the “Output Port” is selected, the output port property as shown in Fig. 4-43 will be displayed in the Properties Toolbar.
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Fig. 4-43 Output Port Parameters
设置输出端口  Set Output Port
[image: image160.png]


The system will provide the port with high-level voltage when the marking comes to the current output port.
[image: image161.png]


The system will provide the port with low-level voltage when the marking comes to the current output port.
[image: image162.png]


 The system will provide the port with a level signal and keep it.
[image: image163.png]


 The system will provide the port with a pulse signal and it can set the pulse width.
4.14.  Encoder moving distance
在绘制菜单中选择“扩展轴”命令，在对象列表中就会显示“扩展轴”对象，如下图 4-49 所示：

Select the “Extended Axis” command in the draw menu, and the “Extended Axis” object will be displayed in the object list, as shown in Figure 4-49 below:
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Fig.4-49   Encoder moving distance
扩展轴1  Extended Axis 1
相对位置  Relative Location
是否回零  Whether to Return to Zero
移动  Move 
毫米  Millimeter
脉冲  Pulse
度  Degree
扩展轴配置  Extended Axis Configuration
 Extended axis correction Zero: Check this to return the motor to zero

Relative position: It means the origin is used as the reference when the motor moves.
Relative position: Indicates whether the motor moves based on the origin or relative position.
Number of moving pulses: how many pulses are sent to the motor, and the number of pulses indicates the motor movement distance.

Unit type：unit of motor movement distance
4.15. Encoder Movement Distance
When the “Encoder Movement Distance” command in the Draw Menu is selected, the “Encoder Movement Distance” will be displayed in the Object List as shown in Fig. 4-50:
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Fig. 4-50 Dialog Box of Encoder Movement Distance
编码器移动距离 1000.000毫米  

Encoder Movement Distance 1000.000 mm

 “Encoder Movement Distance” is mainly used for detecting the movement distance of flying objects during the process of mark on the fly.
4.16. Helical Line

Helix can be added to the outer frame object, and parameters such as equal pitch, unequal pitch, helix setting from inside to outside, from outside to inside, and minimum radius, minimum helix pitch, maximum helix pitch, pitch variation, outer boundary ring number, inner boundary ring number can be selected
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Fig. 4-51 Helical Line Setting Dialog Box
螺旋线  Helix  

确定  OK 

关闭  Close 

笔号  Pen Number
最小半径  3毫米   Minimum Radius  3 mm
最小螺旋线螺距  0.5毫米   Minimum Helix Pitch  0.5mm
最大螺旋线螺距  0.5毫米   Maximum Helix Pitch  0.5mm
螺距变化量   0.1毫米  Pitch Variation  0.1mm  

外边界环数  Number of Outer Boundary Rings 

内边界环数  Number of Inner Boundary Rings 
使能循环  Enabling Cycle  

循环次数  Number of Cycles

4.17.   Graphics picking
The icon [image: image167.png]


 on the top of the Draw Toolbar is used for graph selection.
The depressed state of the icon indicates that the command is selected at that time if no other command is selected, and you can select an object by clicking objects in the workspace with the mouse. The software has the “Auto-snap” function, and you can select an object by clicking the left mouse button if the mouse cursor is near a curve in the workspace.
You can also press the left mouse button and move the mouse to select an object, and there will be a dashed frame in the area where the mouse moves through. Objects wholly included in the dashed frame will be selected. 

When the “Select” command is selected, the Select Toolbar will be displayed, and you can realize some particular operations, as shown in Fig. 4-44:
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Fig. 4-44 Select Toolbar
[image: image169.png]


 It means that the current object is locked and you can’t conduct any editing operations on it. Some lock-like icons will appear around the object at that time.
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 It means unlocking locked object selected currently.
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 It means unlocking all the locked objects.
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 It means placing the selected object to the origin.
[image: image173.png]


 It means selecting objects by the pen number. The dialog box as shown in Fig. 4-45 will be displayed after the command is selected.
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Fig. 4-45 Dialog Box of Selection by Pen Number
按笔号选择对象  Select Objects by Pen Number
笔号  Pen Number 

颜色  Colors
确定  OK 

取消  Cancel
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Indicates that the current selection object will be mirrored horizontally。As shown in figure 4-46 below:
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Fig.4-46 Mirrored horizontally
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Indicates that the current selection is vertically mirrored：As shown in figure 4-47:
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Fig.4-47 Vertically mirrored
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Show or hide the current figure’s marking path ：As shown in Figure 4-48:
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FIg.4-48 Figure’s marking path

5. Modify Menu 

Commands in Modify Menu will take easy operations on selected objects, such as, Array, Transformation, Modeling, Prune etc. (Fig. 5-1)
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图5-1 修改菜单

Figure 5-1 Modify Menu

修改  Modify 

查看  View
阵列  Array 

变换  Transformation 

造型  Modelling 

修剪  Trim 

去除交叉点  Break Cross Point 

自动连接  Auto-Connect 

排序  Resort 

对齐  Align
对于3D图元除了变换内的移动和旋转操作外，其他都不支持，移动和旋转操作会同步到3D图元变换信息内，旋转是绕Z轴旋转。

Except for the movement and rotation operations in the transformation of 3D metafiles, other operations are all not supported. The movement and rotation operations will be synchronized to the 3D metafile transformation information, and the rotation is rotated around the Z-axis. 
5.1. Array

Click “Array”, we can see the dialog box as shown in Fig. 5-2:
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Fig. 5-2 Array Dialog Box
阵列  Array
阵列类型  Array Type
矩阵  Matrix
圆阵  Circular Array
横向数目  Horizontal Number 
纵向数目  Vertical Number
横向间距  Horizontal Spacing
纵向间距  Vertical Spacing
间距计算方法  Spacing Calculation Methods
按偏移距离计算  Calculate by Offset Distance  

按图形间距计算  Calculate by Graph Spacing
确定  OK 

取消  Cancel
Matrix ：Indicates that the pattern will be arranged in a rectangle.

Circle array: The graph according to circle array.

[image: image186.png]


: Indicates that the figures after the array are arranged individually from left to right，At the same time the processing sequence is determined. 

[image: image187.png]


：Indicates that the pattern after the array is arranged in two directions from left to right and then from right to left, It also determines the processing sequence.
Horizontal number：Array is the number of arrays in the X direction.
Vertical number：Array is the number of arrays in the Y direction.

Lateral spacing：The distance between the x-direction graphics after the Array.

Vertical spacing：The distance between the x-direction graphics after the Array.
Calculate by Offset Distance: The space of the graphs is calculated by offset distance. (Fig. 5-3 (a))

[image: image188.png]



Fig. 5-3 (a) Calculate by Offset Distance (b)
Calculate by Graph offset Distance: The space of the graphs is calculated by graph distance. (Fig. 5-3 (b))

If we select the array type of “Circle”, we can see the dialog box as shown in Fig. 5-4:
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Fig. 5-4 Array Dialog Box (Circle)
阵列类型  Array Type
矩阵  Matrix
圆阵  Circular Array
阵列数目  Array Number 
半径  Radius
开始角度  90度  Start Angle  90 degree
角度间距  30度   Angle Spacing  30 degree 
向心  Centripetal
正向  Forward Direction
确定  OK 

取消  Cancel
[image: image190.png]


：Indicates the arrangement order of the pattern after the array. Whether it is arranged clockwise or anticlockwise also determines the marking order.

Components：Indicates how many identical figures you need to array the selected figures

Radius: Array after the graphics accordance circular arrangement. The radius of the circle.

Start Angle: Decision the initial arrangement angle of the pattern after the array.

Angle spacing: The array angle spacing of the pattern after arraying.

5.2. Transformation
When selected, a parameter setting box will appear as shown in Fig. 5-5.
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图5-5 变换操作对话框

Figure 5-5 Transformation Operation Dialog Box
变换  Transformation
位置  Location
X  -46.340 毫米  X  -46.340 mm
Y  -46.536 毫米  Y  -46.536 mm
相对位置  Relative Location
应用到复制对象  Apply to Copy Object
应用  Apply
5.2.1. Move

[image: image192.png]


: Represents a move transform. The move Transform command can translate the currently selected object.

Position: The coordinates of the currently selected object datum mark.

In absolute coordinates, this function is equivalent to the X and Y functions in the attribute toolbar object label in Chapter 2.
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Select a datum mark of an object.
Relative  centere: use relative coordinates
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 Apply to Copy Object: This item is used to copy the currently selected object and move it into a new place.
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: Activate the modification.

[image: image196.png]


: Move selection to a new location
5.2.2. Rotate

[image: image197.png]


: Rotate your object.

[image: image198.png]


: Represents a rotation transform. The rotation transform command rotates the currently selected object.

When selected, a parameter setting will appear in the Rotation Setting Dialog Box as shown in Fig. 5-6.
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Fig. 5-6 Rotation Setting Box
变换  Transformation
角度  45.000度   Angle  45.000 degree
中心  Center
X  -38.164 毫米  X  -38.164 mm
Y  -41.646 毫米  Y  -41.646 mm
相对中心  Relative Center
应用到复制对象  Apply to Copy Object
应用  Apply
Angle: Represents the angle to rotate for the currently selected object.
Center: The coordinates of the currently selected object’s datum mark.

In absolute coordinates, this function is equivalent to the X and Y functions in the attribute toolbar object label in Chapter 2.
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 Select a datum mark of an object, 3D图元此属性不起作用，默认为绕Z轴旋转。
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 Select a datum mark of an object, and the property of 3D metafile does not work. It is rotated around the Z-axis by default.
Relative Center: Change the current coordinates into relative coordinates.

[image: image202.png]


: Let the modification of the current object active.

[image: image203.png]


: Move selection to a new location
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: This item is used to copy the currently selected object and rotate it into a new place.
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 Apply to Copy Object: This item is used to copy the currently selected object and rotate it into a new place.

5.2.3. Mirror

[image: image206.png]


: Represents a mirror transform. The mirror Transform command can mirror the currently selected object.

When selecting mirror command, a parameter setting box will appear as shown in Fig. 5-7.
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Fig. 5-7 Mirror Setting Box 
变换  Transformation
比例  Scale
对象  Object
应用到复制对象  Apply to Copy Object
应用  Apply
Proportion: The zoom ratio of the X/Y size after being mirrored.
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: The current object’s horizontal mirror.

[image: image209.png]


: The current object’s vertical mirror.

The vertical mirror and horizontal mirror can be activated at the same time, activate the corresponding mirror functions as per requirements in actual use, and make sure not to press the function that is not required.
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: Select a datum mark of an object.

[image: image211.png]


: Move selection to a new location
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: This item is used to copy the currently selected object and mirror it into a new place.

5.2.4. Zoom

[image: image213.png]


: Zoom your objects. 缩放变换命令可以将当前选中的对象进行缩放。

 [image: image214.png]


  Represents a scale transform. The zooming transformation command can zoom the currently selected object.
When selected, a dialog box will appear as Fig. 5-8.
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Fig. 5-8 Zoom Setting Box
变换  Transformation
尺寸  Size  

X  16.352毫米    X  16.352mm
Y   9.780毫米    Y   9.780mm
应用到复制对象  Apply to Copy Object
应用  Apply
Size: The size after zooming. This function is the same as the Size which is introduced in object label of properties toolbar in Chapter 2.
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: Select a datum mark of an object.
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: Let the modification of the current object active.
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: Move selection to a new location
[image: image219.png]


: This item is used to copy the object and zoom it into a new place.
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 Apply to Copy Object: This item is used to copy the object and zoom it into a new place.
5.2.5. Tilt
[image: image221.png]


: Lean the currently selected object, 倾斜变换命令可以将当前选中的对象进行倾斜。

[image: image222.png]


:  Tilt the currently selected object, and the leaning transformation command can lean the currently selected object.

When selected, a parameter setting box will appear as shown in Fig. 5-9.
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Fig. 5-9 Lean Tilt Setting Box
变换  Transformation
倾斜  Lean    

X  0 度    X  0 degree
Y  0 度    Y  0 degree
应用到复制对象  Apply to Copy Object
应用  Apply
Tilt: Represents the slope angle of the currently selected object. 

[image: image224.png]Lty
L



: Select a datum mark of an object.
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: Let the modification of the current object active.
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: Move selection to a new location
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: This item is used to copy the currently selected object and lean it into a new place.

5.3.  Modeling
When selected, a parameter setting box will appear as show in Fig. 5-10.
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Fig. 5-10 Modeling
[image: image229.png]


: Indicates welding, you can combine two intersecting closed areas into a closed area.
[image: image230.png]


: Indicates trim, you can trim an enclosed area from a drawing contained in another area.

[image: image231.png]


:Indicates cross，You can combine two intersecting closed areas into a closed area, and only the intersecting parts are retained.
5.4.  prune
The trimming operation is used to trim the curve in the graph. After the user clicks the trimming command, when the mouse moves to the curve that can be trimmed, the mouse will be scissor shaped, and the curve that can be trimmed will be sky blue, as shown in Figure 5-11. At this time, if you click the left mouse button, the line can be trimmed.
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Fig. 5-11 Example of Trim Operation
5.5.  Remove intersections
When users click “Break Cross Point”, the following dialog box as shown in Fig. 5-14 will pop-up:
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Fig. 5-12 Dialog Box of  Remove intersections

 Cut length: It means the length of the Crossover line part that we designed, as shown in Fig. 5-12. Take the following Fig. 5-13 for example:

[image: image234.png]



（a）Before removing the intersection     (b)After removal of intersections

Fig. 5-13 Example Cut length
5.6. Auto-Connect
When selected, a dialog box will appear as shown in Fig. 5-14.

 Automatic connection pitch: If the distance between two curves’ starting and ending points is less than the parameter set, the two curves will be jointed into one.
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Fig. 5-14  Automatic connection pitch
5.7.  Sorting
Select this command in the modify menu or select [image: image236.jpg]


from the main interface. Draw multiple objects, click Sort, the direction of blue arrow in the working area indicates the current marking order. The sorting icon appears above the main interface, as shown below
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Fig.5-15 Resort Sorting
5.8.  alignment
Command “Align” will be available only when more than one object is selected in the workspace. “Align” is used to align the objects users select on the two-dimensional plane. There are several ways to align:

[image: image238.png]


Center point alignment: All objects align center. This way may cause moves on both horizontal and vertical directions.
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 Align Left: All objects align left.
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 Align Right: All objects align right.

[image: image241.png]


  Align up: All objects align top.
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  Align below: All objects align bottom.
 Centered vertically alignment: All objects align vertical. These three ways above only support to move objects on horizontal direction.

Centered Horizontal alignment: All objects align horizontal. These three ways above only support to move objects on vertical direction.

图形等距功能：选中对象

图形，点击横向、纵向等距后，图形会按对象列表栏的顺序，之间的距离相等。

[image: image243.png]


Graphic isometric function: Select the object graph, click horizontal and vertical isometric, the graph will be in the order of object list column, and the distance between them will be equal.

Note: The benchmark to align is according to the last object users select, and other objects align behind it. When you use it, first click the first object, then drag to select multiple objects or press "Ctrl" to click multiple objects, all of which are based on the first selected object.

6. View Menu

The View Menu is used for setting every option for view in the software, as shown in Fig. 6-1.
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Fig.6-1 View menu and status bar menu
系统工具栏  System Toolbar 

状态栏(s)   Status Bar(s)
绘图工具栏  Drawing Toolbar 

缩放工具栏  Zoom Toolbar 

辅助工具栏  Guide Toolbar 

对齐工具栏   Alignment Toolbar
节点编辑栏  Node Formula Bar 
对象列表窗  Object List Window 

对象属性窗  Object Property Window
标刻参数栏  Marking Parameter Bar 
标刻控制栏  Marking Control Bar 

显示标尺  Display Ruler 

显示网络  Display Network
显示辅助线  Display Guide Line  

显示路径  Display Path 

捕捉网络  Snap Network 

捕捉辅助线  Snap Guide Line 

捕捉对象  Snap Object 

轨迹预览  Path Preview 

IO状态  IO State 

生成Gcode  Generate Gcode
6.1. Zoom Toolbar
The Toolbar of the zoom Menu is [image: image246.png]Q& | Q& 4 Q



, and there are seven types for different requirements.

[image: image247.png]


: Fill the whole view area with the area you specified for observation. You need to use the mouse to select the enlarged rectangular area. If you press the right mouse button directly, the current view will be zoomed out by one time with the current mouse position as the center. If you press the left mouse button directly, the current view will be zoomed in by one time with the current mouse position as the center.
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: To move the current view.
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: Zoom in.
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: Zoom out.

[image: image251.png]


: Fill the whole view area with all the objects.

[image: image252.png]


: Fill the whole view area with only the selected objects.

[image: image253.png]


: Fill the whole view area with the whole workspace.

6.2.  Display ruler /display grid /display guide line
Displays horizontal and vertical rulers, grid points, and guides.

6.3.  Capture Grid
This item is used for automatically putting the dots you draw on the grid.

6.4.  Capture Guide Line
The capture grid capability enables the points you draw to automatically be on the grid points in the workspace.

6.5.  Capture Objects
During performing some operations, this item is used for automatically snapping an object’s top, center, nodes, circle center, intersect points, etc.

6.6. System Menu Bar/Toolbar/Status Bar/Interface Window Bar
Software supports many toolbars to achieve different functions. Toolbars can be either displayed or hidden by selecting corresponding options in View Menu; and also the Status Bar can be displayed or hidden, either. When there is a “√” selected in front of the submenu, the corresponding toolbars on Status Bar is visible, and if not, they are hidden.

6.7. IO State
Check the status of current input and output ports. If checked, figure 6-2 will be displayed:
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Fig.6-2 IO Status
输入端口  Input Port
输出端口  Output Port
6.8.  Path preview 

Select this function to see the path of the drawing.

7. Special

特殊菜单在SeaCad 软件中的各种选项，如图 7-1 所示。

Various options of the special menu in SeaCad software are shown in Figure 7-1.
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Fig.7-1 Special
改变文本  Change Text
序列号文本  Serial Number Text
设置快捷打印按钮  Set Quick Print Button
SQL数据库文本  SQL Database Text

7.1. Change Text
Click change text, follow dialog window will pop-up, as shown in Fig. 7-2.
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Figure 7-2 Change Text

The content under ‘text’ is to be replaced, the content under ‘change to’ is that after replace.
改变文本  Change Text
源文本  Source Text
变换后的  Transformed
确定  OK
退出  Exit
7.2. Serial number text
All serial numbers under the current file are directly increased or decreased according to their respective increments, or reset to the starting serial number without marking.

8. Laser
“Laser” menu mainly aims at expansion axis control, as shown in Fig. 7-1 below:
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Fig.8-1 Laser
旋转与运动测试  Rotation and Movement Test
旋转角度标刻  Rotation Angle Marking
扩展轴标刻  Extended Axis Marking
旋转文本标刻  Rotate Text Marking
多文件标刻  MultiFile Marking
8.1. Rotate and Move test（Lite version does not support this feature）
The parameters used to set and maintain the extension axis.
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图8-2 旋转配置与检查

Figure 8-2 Rotation Configuration and Test
配置参数  Configuration Parameters 

扩展轴1  Extended Axis 1
字符迎着打  Print by Facing to Characters   

反转  Invert 

旋转轴  Rotation Axis 
减速比  Reduction Ratio 

每转脉冲数  Pulses per Revolution 

每转距离  Distance per Revolution
最小坐标  -1000毫米  Minimum Coordinates  -1000 mm

最大坐标   1000毫米  Maximum Coordinates  1000 mm

最小速度   100脉冲/秒  Minimum Speed   100 pulses/second

最大速度   5000脉冲/秒  Maximum Speed   5000 pulses/second

加速时间   100毫秒  Acceleration Time  100 ms
电机启动速度   700 脉冲/秒  Motor Startup Speed   700 pulses/second 
电机运行速度   6400 脉冲/秒  Motor Running Speed   6400 pulses/second

零点  Zero
回原点速度  5000脉冲  Return-to-origin Speed  5000 pulses

回原点超时  100秒  Return-to-origin Timeout  100 seconds  

精确回零  Accurate Back to Zero
间隙补偿    0.2毫米  Backlash Compensation   0.2 mm 

错位补偿    0毫米   Dislocation Compensation   0 mm 

测试  Test  

确定  OK 

关闭  Close
Reversal: It refers to the movement in the opposite direction of the extension axis; when checked, it indicates that the extension axis is reversed.
字符迎着打：改变文本标刻的先后顺序。

Character to meet：Change the sequence of text marking.

Pulses per Round: The pulse (subdivision of driving motor) numbers each round that the expansion axis rotating. It can be set according to the motor parameter.

Distance  per revplution：The distance each round that the expansion axis rotating，Click the setting button "..." to calculate a more accurate distance per round.
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Fig.8-3 Extended axis accuracy setting
扩展轴每转距离计算  Distance Calculation for Extended Axis per Revolution 

反向  Reverse
运动转数  Movement Revolutions 
运动  Movement
实测移动距离  Actual Movement Distance
确定  OK 

关闭  Close
Min Coordinate: The smallest coordinate in which the extended axis can move, in millimeters.
Maximum Coordinate: The maximum coordinate of the extended axis that can be moved, in millimeters.
Min. Coordinate: The minimum speed of the extended axis energy movement, unit pulse / second.

Max. Coordinate: The maximum speed of the extended axis, unit pulse / second.

Acceleration: The time, in milliseconds, required for the extended shaft to accelerate from the minimum speed (starting speed of the motor) to operation.

Go to Start Position After Finished: When it is checked, the expansion axis will go back to the initial position after finishing marking.

 Motor starting：Set motor start speed, unit is pulse/s。

 Motor running: The rotating speed of motor.

Rotation axis: Select it, it's indicates that current expansion axis is rotation axis. 
Reduction ratio：If the motor is directly connected to the shaft, the reduction ratio is 1; if there is a reduction mechanism in the middle, it is the reduction ratio of the reduction mechanism.
Part Diameter: It is used for setting the external wall diameter of round parts and converting graphs in workspace into the accurate rotation angle.

Zero point: Whether the current extension axis has zero signal. When there is no enable zero signal for the extended axis, an absolute coordinate system cannot be established for the extended axis. In this case, it is necessary to adjust the position manually so that each machining is in the same position. Before each machining, the system takes the current extended axis position as the default zero position.

If the zero is selected, the system will automatically look for zero point when employing the expansion axis function. After finding the zero point, an absolute coordinate system will be built for the expansion axis. If the system fails to find the zero point, the expansion function will not be activated properly until the time set for “Zero Time Out” is over.

如无零点信号，则必须将零点的勾选至[image: image260.png]¥



状态，即不使用零点信号状态。

If there is no zero signal, the zero must be checked to the[image: image261.png]¥



 zero state, that is, the zero signal state is not used.

Zero return: The speed at which the extended axis seeks the zero point signal.

Zero return: Set the time for the extension axis to find the zero point. If the time exceeds this time, the system will prompt "return to zero timeout".

Accurate Zero: When it is selected, it is required to receive three signals before going back to zero; if not selected, only one signal is required for going zero.

Gap Clearance compensation: Used to set the interval compensation between each independent figure. For example, the interval between two figures is set to 10mm. If the mark is 10.1, then the gap compensation bit - (10.1-10) =- 0.1.

Offset compensation：When the graphics are stitched, it may cause mismatch phenomenon. This parameter is used to eliminate the misalignment.

Rotation Test：Test Rotary Axis.
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Fig.8-4 Rotate test
旋转测试  Rotation Test
旋转轴  Rotation Axis
工作直径  Working Diameter
脉冲数  Pulses
反转  Invert
正转  Corotation
紧急停止  Emergency Stop
8.2. Rotation Angle Marking（Lite version does not support this feature）
8.2.1Interface description
"Rotation Angle Marking" is to perform rotation marking according to the angle of the rotation axis to process the entire figure.

Click on the "Rotation Angle Marking" menu item under "Laser" to display the following dialog box:
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Fig.8-5 Rotate angle mark
旋转角度标刻  Rotation Angle Marking
旋转轴  Rotation Axis 

停止  Stop 

加工总数   Total Number of Processing
连续加工  Continuous Processing 
选择加工  Selective Processing
输入端口打标  Input Port Marking 

按图标刻  Marking by Graphs
等角标刻  Equiangular Marking
360度旋转标刻  360 Degree Rotation Marking 

每周次数   Times per Week
标刻完返回起始点  Return to Start Position after Marking 

完成次数  Number of Completions 

总时间  Total Time 
红光指示  Red Light Indicator 
标刻  Marking 

参数  Parameters 

退出  Exit 

打标未开始……    Marking Not Started......
对话框中，各数据项说明如下：

In the dialog box, the data items are described as follows:

Total Number: The total counts that the marking command should be executed. If checking the “Continuous”, the marking number will not be limited by the total number;

Rotary Axis：Choose which axis to use；

Continuous Mark: If it is checked, it will not be controlled by the total number, and it will perform continuous marking for graphs or text contents displayed in the workspace.

Mark Selected: If it is checked, only those selected graphs will be marked; otherwise, all the graphs will be marked;

Input port marking: Specify an input port and the marking can be triggered through the IO port.

Press icon: After each engraving, rotate the z-axis coordinate value (angle) of the graph. Different graphs can set different rotation angles

Increment mark: Rotate the mark according to the set angle interval.

360 degree rotating mark: Set how many times to mark the figure in a week;

Mark back to the starting point: When this option is checked, the rotation axis will return to the starting point of the marking.

Completion times: The total counts that the marking command has been executed;

R：Reset the marking status and clear marking count；

Total Time： Total time of marking.
8.2.2Functional operation

8.2.2.1 Red light

Click on the "red light " button, you can see the red indicator of the current graphics.

8.2.2.2 Mark

Click "Mark", and the software marks according to the set parameters.

8.2.2.3 Parameters

Click "parameters" to configure the relevant parameters of the rotation axis. (refer to 8.1 for parameter description).

8.2.2.4 ESC drop out

Click "ESE drop out ", the system will save the configured parameters for the next use.

Note: If you click the "X" button in the upper right corner of the dialog, 
the modified parameters are not saved.
8.3. Expansion Axis Marking（Lite version does not support this feature）
The extended axis marking function is to divide the entity into specified sizes and then splice the marking while rotating. The interface is as follows:
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Fig.8-6 Extend axis mark
扩展轴标刻  Extended Axis Marking
加工总数   Total Number of Processing

连续加工  Continuous Processing 
选择加工  Selective Processing
输入端口打标  Input Port Marking 

标刻完成回零点  Return to Zero After the Completion of Marking
红光完成回零点  Return to Zero After the Completion of Red Light

零件  Part
总时间  Total Time
扩展轴  Extended Axis

扩展轴方向  Extended Axis Direction
运动步长  Movement Step Length
工件直径  Workpiece Diameter 
急停  Emergency Stop 
红光指示  Red Light Indicator 
标刻  Marking 

参数  Parameters 

退出  Exit 

打标未开始……    Marking Not Started......
扩展轴方向：选择旋转轴的使用方向。

Extended Axis Direction: Select the use direction of the rotation axis.
 Workpiece：Diameter of Axis.
运动步长：图元分割的大小。

Movement Step Length: The size of the metafile split.
8.4. Rotate Text Mark（Lite version does not support this feature）
Rotate Text Mark is a marking method in which the text is divided by each character and then the individual characters are marked while being rotated.

Click the “Rotation Text Marking” in the “Laser” menu of the menu bar to open the rotation text marking dialog box, as shown in Fig.8-9:
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Figure.8-9 Rotate Text Mark

The configuration parameters are the same as those for the Rotary marking.
旋转文本标刻  Rotation Text Marking
加工总数   Total Number of Processing

连续加工  Continuous Processing 
选择加工  Selective Processing
输入端口打标  Input Port Marking 

标刻完成回零点  Return to Zero After the Completion of Marking
红光完成回零点  Return to Zero After the Completion of Red Light

零件  Part
总时间  Total Time
扩展轴  Extended Axis

扩展轴方向  Extended Axis Direction
工件直径  Workpiece Diameter 
运动步长  Movement Step Length
停止  Stop 
红光指示  Red Light Indicator 
标刻  Marking 

参数  Parameters 

退出  Exit 

打标未开始……    Marking Not Started......
8.5 Multi-File Mark 

The function of "multi file marking" is used to trigger IO to mark multiple different marking files to avoid frequent changes of marking files. The function menu is: "laser" - > "multi file marking".

The operation interface is as shown in Figure 8-10: the text box on the left displays the file name, and the preview graphic of the selected file appears after the preview graphic is checked on the right border. Double click the file name to open the engraving file in the main interface for editing.

Double-click on the file name and open the marking file on the main screen to edit it.
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Fig.8-10 Multifile Mark
多文件标刻  MultiFile Marking 

方案名称  Solution Name 

预览图形  Preview Graph 

关联设备  Related Equipment 
文件  File 

打标  Marking 

触发条件  Trigger Condition 
增加  Add  

删除  Delete 
上移  Move Up 

下移  Move Down 

修改  Modify 

次数清零  Frequency Zero 

使能有效  Enabling Effective 

同端口顺序触发  Trigger in the Same Port Sequence

同端口全部触发  Trigger All on the Same Port 
打开方案  Open Solution 
保存方案  Save Solution
标刻  Marking 

退出  Exit
8.5.1. File Manage
Add: Add .orz files. The dialog box pops up as Figure 8-38 after click “add” button. Setting I/O control conditional for files, and automatically mark files when board accept the IO signal in mark status.
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Fig.8-11 File Menu
文件  File
文件名称  File Name
I/O控制条件  I/O Control Condition
当前标刻  Current Marking
确定  OK
关闭  Close
Gray：Gray means not used 
Blank：Blank means low level 

Black Hook：Black Hook means high level.

Delete: delete files.

 "Move up", "move down": change the order of files.
Modify: change file selected and IO control conditional
8.5.2. function Option
 Sequential trigger on the：Use a port to mark the preset files in order.
Trigger All on the Same Port: If different documents are the same port, then triggering the port once will mark all documents.

Open plan：Open saved multi-file marking scheme.

Save plan：Save the currently designed multi-document marking content as a scheme.
Mark：After clicking, software will enter the state of waiting for the IO 
signal to trigger. At this time, the IO signal can be triggered to mark the corresponding document.
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Fig.8-12 Marking Interface
同端口顺序触发  Trigger in the Same Port Sequence
打开方案  Open Solution 
保存方案  Save Solution
停止  Stop
退出  Exit
等待IO信号  Wait for IO Signal
9. Mark parametr

Including single-card marking and multi-card marking.

9.1. 笔参数管理Pen Parameter Management
9.1.1. 笔参数列表Pen Parameter List
在SeaCAD中每个文件都有257支笔，对应在加工属性栏中最上面的256支笔，笔号从0到256，其中0号笔是笔模板参数（可以基于该笔号修改其他笔号参数）。

In SeaCAD, there are 257 pens in each file, corresponding to the top 256 pens in the processing property bar, the pen number ranges from 0 to 256, where the pen 0 is the pen template parameter (other pen number parameters can be modified based on the pen number).
如图9-1所示是标刻控制栏。

As shown in Figure 9-1, it is the marking control bar.
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Fig.9-1 Marking tool bar
标刻参数栏  Marking Parameter Bar 

笔号  Pen Number 

开关  Toggle 

名称  Name 

加工  Processing 

使用默认参数  Use Default Parameters 

笔号  Pen Number 

加工数目（件）  Processing Number (piece)
速度（mm/s）   Speed (mm/s)
功率（%）   Power (%)
频率（KHZ）   Frequency (KHZ)
脉宽（ns）   Pulse Width (ns)
开光延时   Light-on Delay
关光延时  Light-off Delay 

结束延时  End Delay 

拐角延时  Corner Delay 

光斑演示  Flare Demonstration 
高级设置  Advanced Settings
参数名称  Parameter Name 

保存  Save 

从参数库选取参数  Select Parameters From Parameter Library
设置成默认参数  Set as Default Parameters
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表示当前笔要加工，即当加工到的对象对应的为当前笔号时要加工，双击此图标可以更改。
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 Open indicates that the current pen is to be processed, that is, when the processed object corresponding to the current pen number to be processed, double click this icon to change it.
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表示当前笔不加工，即当加工到的对象对应的为当前笔号时不加工。
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Turn Off indicates that the current pen is not processed, that is, when the processed object corresponding to the current pen number, it is not processed.

Color: The current pen’s color, which will be displayed when the object is corresponding to the current pen number, 双击颜色条可以更改颜色。

Color: The current pen’s color, which will be displayed when the object is corresponding to the current pen number, double click the color bar to change the color.

参数应用按钮：当用户按参数应用按钮时当前被选择的对象的笔号会被更改为对应的按钮笔号。如图9-2。

Parameter Application Button: When the user presses the parameter application button, the pen number of the currently selected object will be changed to the corresponding button pen number. As shown in Figure 9-2.
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图9-2 参数应用按钮

Figure 9-2 Parameter Application Button 

当用户在当前列表中按鼠标右键时会弹出如图9-3所示的右键菜单。

When the user presses the right mouse button in the current list, the right button menu as shown in Figure 9-3 will pop up.
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图9-3 右键菜单

Figure 9-3 Right Button Menu
选择列  Select List
应用到选择对象  Apply to the Selected Objects
设置为默认笔号  Set as Default Pen Number
9.1.2. 高级设置 Advanced Settings
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Here we will introduce the specific meaning of each parameter in details.
笔号参数  Pen Number Parameter  

当前笔号  Current Pen Number 
参数名称  Parameter Name 

开启  Start 

颜色  Color 

加工数目（件）  Processing Number (piece) 

速度（mm/s）  Speed (mm/s) 

功率（%）  Power (%) 

电流（A）  Current (A)
频率（KHZ）  Frequency (KHZ) 

MOPA脉宽（us）  MOPA Pulse Width (ns) 

Q脉宽（us）  Q Pulse Width (ns)  

开光延时（us）  Light-on Delay (us)
关光延时（us）  Light-off Delay (us)
结束延时（us）  End Delay (us)
拐角延时（us）  Corner Delay (us) 

标刻步距（mm）  Marking Step Distance (mm)

步间延时（us）  Inter Step Delay (us) 

高级参数  Advanced Parameters 
跳转速度  Jump Speed 

跳转位置延时  Jump Position Delay 

跳转距离延时  Jump Distance Delay 

跳转延时限定  Jump Delay Limit
最小跳转延时  Minimum Jump Delay 

最大跳转距离  Maximum Jump Distance 
末点补偿  End Point Compensation 

加速距离  Acceleration Distance 
打点时间  Dotting Time 

矢量打点模式  Vector Dotting Mode 

每个脉冲点数  Points per Pulse 

开光滞后  Light-on Lag 

抖动  Dithering
圆直径  Circle Diameter 

间距  Spacing 

末尾加点  Add Point at the End 

数目  Quantity 

距离  Distance 

打点时间  Dotting Time 
打点次数  Dotting Times 

重置  Reset  

设为默认笔号  Set as Default Pen Number 

确定  OK
关闭  Close

基本参数区: 

Basic Parameter Area:

Current Pen Number: The set of marking parameters currently used. In SeaCAD, the concept of “pen” is equivalent to a set of given marking parameters.

 Processing (pieces): The marking times for each object during one marking are equivalent to the marking quantity in its marking parameters.

Speed: The marking speed of current marking parameters.

Power: This item indicates the power percentage of the current marking parameter, and 100% refers to the maximum power of current laser.

Frequency: The laser’s frequency in the current marking parameter.

 Mopa pulse width: The ratio of laser pulse duration to pulse period.

Opening delay: Delay time of laser on at the beginning of marking. Setting the appropriate delay parameter can remove the "match head" at the beginning of marking, but if the delay parameter setting is too large, it will lead to the lack of pen at the beginning. It can be a negative value, which means that the laser light comes out ahead of time.

Off light delay: Delay time for laser off at the end of marking. Setting the appropriate light off delay parameter can remove the non closing phenomenon when the marking is completed, but if the light off delay setting is too large, the end segment will appear "match head". Cannot be negative.

End delay: Generally, it takes a period of response time from the time when the light off command is sent to the time when the laser is completely shut down. Setting an appropriate end delay is to give the laser a sufficient light off response time, so as to achieve the purpose of making the laser carry out the next marking when the laser is completely shut down, and prevent the light from leaking and the phenomenon of point rejection.

Polygon TC: Delay time between each segment during the marking. The proper Polygon TC parameters set can eliminate the circular angle appears during right angle marking, while the too large ones may cause marking time increase and double points at the corner.

Corner delay: Delay time between each segment during marking. If the corner delay is set too much, the marking time will increase, and the corner will have the key phenomenon.
高级参数区: 

Advanced  Parameter Area:

Jump Speed: Set a jump speed corresponded by the current parameter.

Jump Position: Jump position delay value.

Jump Distance:  Jump distance delay value.

After each jump movement, the system will delay some time, and then execute the next command. The actual delay time is calculated by the following formula:

Jump delay = jump position delay + jump distance × jump distance delay;

End Point: Generally, this parameter does not need to be set. Only in high-speed machining, when the delay parameter cannot be adjusted to make the end point in place, this value is set to force the marking of a straight line with the length of the compensation distance of the end point at the end of machining. Negative values are acceptable.

Acceleration Distance: This parameter may be set properly to eliminate the uneven dotting at initial marking segment.

Dotting Time: It indicates light emitting time of each point in case that point objects exist.

Vector Dotting Mode: It indicates to compulsively specify the fixed pulse number given out by the laser during each point marking.
Add Point at the End: It is used to solve the problem of laser end shining. The software will automatically add points at the end of each pen, but will not display it as an object.

number:  number of points added at the end.

Distance: Distance between the points added at the end.

Dotting Time: Marking time for each point added at the end.

Dotting Times: Marking times for each point added at the end.
9.2. Region parameter 
9.2.1. Configuration Config[default]
See Fig. 9-4 for the field parameter of equipment:
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Figure.9-4  Configuration Config[default]
配置参数 [default]  Configuration Parameters [default]
区域  Area 
激光控制  Laser Control 
端口  Port 

其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information
外观  Appearance 
区域尺寸  Area Size 

偏移X  Offset X  

偏移Y  Offset Y 
角度  Angle 

最大线长  Maximum Line Length 

使用校正文件  Use Correction File 

XY互换  XY Interchange 

X反向  Reverse X 
Y反向  Reverse Y 
比例  Scale 

比例  Scale 

等分比例法  Equal Scale Method 
使用配置文件  Use Configuration File

计算推荐值  Calculate Recommended Value 

密码  Password 
密码  Password 

参数另存为  Save Parameter As 
确定  OK
关闭  Close
Area Size: The actual widest range for marking corresponded by the scanhead.。
Offset X: The offset distance of scanhead center in X direction from field lens center.

Offset Y: The offset distance of scanhead center in Y direction from field lens center.

Angle: Adjust the angle of the galvanometer.

Maximum line length: The maximum length of the line segment that is divided by the figure. It is used to split the line segment beforehand to deliver the data, so as to improve the marking accuracy.
Use the Calibration File: Use the calibration file generated by external calibration program to calibrate the scanhead.

XY Change: Change the axes corresponding to the original galvanometer signal 1 and signal 2.
reverseX/reverseY: The opposite direction of the current scanhead.
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indicates the barrel distortion or pincushion distortion calibration coefficient with default of 1.0 (parameter range: 0.875-1.125).
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 indicates the parallelogram calibration coefficient with default of 1.0 (parameter range: 0.875-1.125).
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indicates the trapezium calibration，with default of 1.0 (parameter range: 0.875-1.125).

Scale: It refers to the flex percentage, and the default is 100%. This parameter will be adjusted when the trim size marked is different from the setting size. If the trim size is smaller than the designed one, users can raise this parameter; if the trim size is bigger than the designed one, users can lower this parameter.

Note: If there are some distortions with the laser scanhead, users must firstly adjust the distortions and then the flex percentage.

During scale setting, we may press the button [image: image281.jpg]


 directly, and a dialog box like Fig. 9-5 will be popped up. After we input the set size in software and the actual marking size measured, the software will automatically calculate the flex percentage.
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计算比例  Calculation Scale
目标标刻尺寸  Target Marking Size
实际标刻尺寸  Actual Marking Size
确定  OK
取消  Cancel
Fig.9-5 Calculate scale
等分比例法：校正时是否使用等分线计算缩放比例（详见10.2手工校正）。

Equal Scale Method: Whether to use the bisectrices to calculate the zooming scale during correction (see 10.2 manual correction for details).

Go to Specified Position after Marking: After the completion of current marking, move the scanhead to its specified position.
Password: Set the current parameters can only be changed by entering the password。
9.2.2. Laser Parameter

See Fig. 9-6 for the laser parameter of equipment:

[image: image283.png]EESdefault]

EiE WA WO EE DHET EEER
e
Ocoz Ovas Ovoet Omora @rber Ot OQcw
oo A%
BRPMESHL iR
BorewniEs
S NI
s BRI
e =
e oo A R
e
5% so00 | 0tz
MO ms
A b
e wo % CIERECITEEGE
TR 10 % DFRMERERS
EDs] [0 Jww s
R 0
} PRI ¢
oE e 10
Aol 0 u e
RE 20w — Iy
e
. B L
RS ] ok
TR s
RO —~

MaxV 500 VMRV 000 VTL 100 us T2 1000 us

Fifl





配置参数 [default]  Configuration Parameters [default]
区域  Area 
激光控制  Laser Control 
端口  Port 

其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information

激光器类型  Laser Type
使能PWM信号输出  Enable PWM Signal Output
开关  Toggle 

使能Violet激光器首脉冲抑制  Enable Violet Laser First Pulse Suppression
最大PWM信号  Maximum PWM Signal

最小PWM信号  Minimum PWM Signal
功率映射  Power Mapping
紫外模拟红光模式  UV Analog Red Light Mode
脉宽反转  Pulse Width Invert
使能预电离  Enable Preionization
脉冲宽度  1微秒  Pulse Width  1 microsecond
脉冲频率  Pulse Frequency
使能功率缓升/缓降  Enable Power Ramp Up/Ramp Down  

类型  Type 

漏光处理  Light Leakage Treatment  

开启MO延时  Start MO Delay
起始功率  Initial Power 

功率增量  Power Increment 

首脉冲抑制  40微秒  First Pulse Suppression  40 microseconds
使能脉冲宽度设置  Enable Pulse Width Setting
不检测激光器反馈信号  Do not Detect Laser Feedback Signal

波形SPI首脉冲抑制  Waveform SPI First Pulse Suppression
起始功率  Initial Power 
连续光模式  Continuous Light Mode
发送   Send
Q脉宽  Q Pulse Width
最小Q脉宽  Minimum Q Pulse Width
最大Q脉宽  Maximum Q Pulse Width
模拟输出  Analog Output
使能电流输出  Enable Current Output
使能频率模拟输出  Enable Frequency Analog Output
使能模拟的首脉冲抑制  Enable Analog First Pulse Suppression
电流映射  Current Mapping
频率映射  Frequency Mapping
测试激光  Test Laser
确定  OK
关闭  Close
Figure.9-6 Laser Control
Please carry out the adjustment as per the actual parameters of laser machine.

9.2.3. Port Parameter

See Fig. 9-7 for the equipment port parameter.
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配置参数 [default]  Configuration Parameters [default]
区域  Area 
激光控制  Laser Control 
端口  Port 

其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information
停止加工输入端口  Input Port of Stopping Processing
停止加工时的提示信息  Prompt Message When Stopping Processing
忽略输入信号  Ignore Input Signal
忽略输入信号  Ignore Input Signal

激光电源输出口  Output Port for Laser Power Supply

端口  Port
红光指示输出口  Output Port for Red Light Indicator 

输出端口  Output Port
输入端口  Input Port
标刻输出口  Marking Output Port

输出端口  Output Port
输出端口  Output Port
门端口  Gate Port
输入端口  Input Port
激光准备好端口  Laser Ready Port

输出端口  Output Port
输入端口  Input Port
标刻结束输出IO  Output IO After Finishing Marking 
脉冲宽度  Pulse Width
开始标刻端口  Mark Starting Port
输入端口  Input Port
开始信号脉冲模式  Start Signal Pulse Mode
滤波时间  Filter Time
确定  OK
关闭  Close
Figure.9-7 Port
Input Port of Stopping Marking: Certain input port is specified as marking stopping port. During marking process, if the system detects there is a corresponding input signal, the current marking operation will be ended, and prompt the users with error information.

Gate Port: Check the port signals for safety gate opening and closing and make sure the marking will automatically stop in case of safety gate opening (red light indication may continue being used) so as to protect the operators from being burnt.

Laser Power Supply Output Port: This port may be used to control the on-off of laser power supply.

Red Light Pointer Output Port: The system will output high level to the appointed output port during red light pointer.

Mark Output Port: The system will output high level to the appointed output port during marking.

Mark Starting Port: In idle state, the system will start marking automatically if high level is output by the appointed input port.

Start Signal Pulse Mode: Checking this option means the start signal is marked by software in pulse mode, even for continuous level input, the software only reads one pulse. Otherwise the input port marked is of continuous level.

9.1.2.4. Red Light
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配置参数 [default]  Configuration Parameters [default]
区域  Area 
激光控制  Laser Control 
端口  Port 

其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information
使能端口红光打标  Enable Port Red Light Marking
红光样式  Red Light Style 
图形外接矩形框  Graphic External Rectangular Box
红光速度  Red Light Speed
偏移X  Offset X  

偏移Y  Offset Y

尺寸比例X  Size Scale X
尺寸比例Y  Size Scale Y
内置红光模式  Built-in Red Light Mode

红光预览  Red Light Preview
确定  OK
关闭  Close
Figure.9-10 Red Light
Red light style: Used to select the red light to display the bounding rectangle of the figure or the outline of the figure.

Red Light Speed: It indicates the system movement speed in case of red light pointer.
Offset Position: It indicates the system movement offset position in case of red light pointer and may be used to compensate the position error between red light and actual laser.
Size Scale: It refers to the size deviation between red light and laser, by adjusting which the two can completely coincide.

9.1.2.5. Others
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配置参数 [default]  Configuration Parameters [default]
区域  Area 
激光控制  Laser Control 
端口  Port 

其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information

开始标刻延时  Delay for Starting Marking
结束标刻延时  Delay for Finishing Marking
最大速度  Maximum Speed
最小速度  Minimum Speed
显示开始标刻对话框  Display the Dialog Box for Starting Marking

加工到指定数目后禁止加工  

Forbid Processing after Designated Processing Number is Achieved

总加工时间   2655毫  Total Processing Time  2655 milli

总零件数  Total Parts
确定  OK
关闭  Close
Figure.9-11 Others
Delay for Starting Marking: Start the marking after delay of appointed time at the beginning of each marking.

Delay for Finishing Marking: Finish the marking after delay of appointed time at the end of each marking.

Forbid Marking after Designated Marking Number is Achieved: When the parts number reaches the total marking number designated, the system will pop up a dialog box to prompt that “the current number has exceeded the total marking number, please reset it, and then start marking”.

Display the Dialog Box for Starting Marking: After checking, it will prompt a dialog box of “whether to start marking” for each time selecting marking, as shown in Fig. 9-12.
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提示  Tip
是否开始标刻？  Do you start marking?

确定  OK
取消  Cancel
Figure.9-12 Start Marking Dialog
9.1.3.Mark
The Marking dialog box is at the bottom of the SeaCAD interface, as shown in Fig.9-13.
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红光  Red Light
标刻  Marking 

连续加工  Continuous Processing 

零件  Part
选择加工  Selective Processing 

总数  Total Number 
下载至板卡  Download to Board 
参数  Parameter 

自动红光  Auto Red Light 

红光显示轮廓  Red Light Display Outline

连续红光模式  Continuous Red Light Mode
Fig.9-13 Marking Dialog
Red Light: This item is used to mark the frame of the object without laser output and indicate the marking area so that users are convenient to orient the workpiece. This function is available in those laser machines which have red guide light. Key “F1” is the shortcut key of this function.

Mark: To execute marking. Key “F2” is the shortcut key of this function.

Continuous: Mark the current object repeatedly without stop.

Mark Selected: Only those selected objects would be marked.

Part: It indicates the total quantity of parts which have been marked.

Enable display outline: Check this function to display the outline of the figure when displaying red light.
Total Number: It indicates the total parts to be marked, which is ineffective under the mode of Continuous Marking. If the total part number is more than 1, the marking operation will not stop until the number of parts marked is equal to the total part number.

R: Marking parts reset.
Parameter: It is used for equipment setting.

下载至板卡：将当前数据下载至板卡缓存中开始离线打标模式。

Download to Board: Download the current data to the board cache to start offline marking mode.

Enable Continuous Red Light Marking Mode: After selecting this function, returning to the software interface and clicking “Marking”, a dialog box as shown in Fig. 9-14 will appear. It will appear after each marking and red light preview will always exist.
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标刻  Marking
红光指示中  Red Light Indicating
Fig.9-14 Continuous Red Light Marking Mode
10. Scanhead Calibration
10.1.Direction adjustment
The direction needs to be adjusted to the same direction as the drawing area before the calibration.

For example, draw a text in the drawing area, as shown below:
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Try to change the three checkmarks in the blue box below and mark until the marked figure matches the drawing area.
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配置参数 Configuration Parameters
区域  Area 
激光控制  Laser Control 
端口  Port  

高级参数  Advanced Parameters 

飞行标刻  Flight Marking
其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information

外观  Appearance 
区域尺寸  Area Size 

偏移X  Offset X   
角度  Angle 

最大线长  Maximum Line Length 

使用校正文件  Use Correction File 

XY互换  XY Interchange 

X反向  Reverse X 
Y反向  Reverse Y 

加工后去指定位置  Go to the Designated Position After Processing

不移动  Do Not Move 
振镜中心  Galvanometer Center 

对象左上角  Upper Left Corner of Object 

对象右上角  Upper Right Corner of Object 

对象右下角  Lower Right Corner of Object  

对象左下角  Lower Left Corner of Object  

指定位置  Designated Position
振镜1  Galvanometer 1
比例  Scale
振镜2  Galvanometer 2
比例  Scale
等分比例法  Equal Scale Method

密码  Password
密码  Password
使用配置文件  Use Configuration File
参数另存为  Save Parameter As
确定  OK
关闭  Close
10.2. Manual Correction
Manual correction, enter from the right parameter (F3), as shown in the blue box in the figure below. By default, the galvanometer 1 corresponds to x and the galvo mirror 2 corresponds to y. If the xy swap is checked, the galvanometer 1 corresponds to y. Galvo 2 corresponds to x：
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配置参数 Configuration Parameter
区域  Area 
激光控制  Laser Control 
端口  Port  

高级参数  Advanced Parameter 

飞行标刻  Flight Marking
其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information

外观  Appearance 
区域尺寸  Area Size 

偏移X  Offset X   
偏移Y  Offset Y 

角度  Angle 

最大线长  Maximum Line Length 

使用校正文件  Use Correction File 

XY互换  XY Interchange 

X反向  X Reverse  
Y反向  Y Reverse  

加工后去指定位置  Go to the Designated Position After Processing

不移动  Do Not Move 
振镜中心  Galvanometer Center 

对象左上角  Upper Left Corner of Object 

对象右上角  Upper Right Corner of Object 

对象右下角  Lower Right Corner of Object  

对象左下角  Lower Left Corner of Object  

指定位置  Designated Position
振镜1  Galvanometer 1
比例  Scale
振镜2  Galvanometer 2
比例  Scale
密码  Password
密码  Password
使用配置文件  Use Configuration File
参数另存为  Save Parameter As
确定  OK
关闭  Close

10.2.1.Shape adjustment
Adjust the curvature, trapezoidal deformation, parallelogram deformation.

Each time you change the curvature, trapezoid, and parallelogram parameters, click "Mark test rectangle" until it is square.
10.2.2.Zoom
According to the marked figure, measure the actual size,Zoom in/out, as shown below:
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计算比例  Calculation Scale
目标标刻尺寸  Target Marking Size
实际标刻尺寸  Actual Marking Size
确定  OK
关闭  Close

In the first step, click on the “marking X scale line” and the software mark a line in X direction.
10.2.3.等分比例法 Equal Scale Method
对于精度要求比较高的场景，可以使用等分线来提高精度。

For scenes with high precision requirements, you can use bisectrices to improve precision.

注意：在使用等分比例前，应该将图形的弯曲、梯形、倾斜形变都校正目标精度范围。

Note: Before using the equal scale, the bending, trapezoid and tilt deformation of the graph should be calibrated for the target precision range.

勾选 “等分比例法”，出现如下图：

Check the “Equal Scale Method” and the following figure appears:
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配置参数 Configuration Parameter
区域  Area 
激光控制  Laser Control 
端口  Port  

高级参数  Advanced Parameter 

飞行标刻  Flight Marking
其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information

外观  Appearance 
区域尺寸  Area Size 

偏移X  Offset X   
角度  Angle 

最大线长  Maximum Line Length 

使用校正文件  Use Correction File 

XY互换  XY Interchange 

X反向  X Reverse  
Y反向  Y Reverse  

加工后去指定位置  Go to Designated Position After Processing

不移动  Do Not Move 
振镜中心  Galvanometer Center 

对象左上角  Upper Left Corner of Object 

对象右上角  Upper Right Corner of Object 

对象右下角  Lower Right Corner of Object  

对象左下角  Lower Left Corner of Object  

指定位置  Designated Position
振镜1  Galvanometer 1
比例  Scale
振镜2  Galvanometer 2
比例  Scale
密码  Password
密码  Password
等分比例法  Equal Scale Method
比例线数  Scale Line Number 
标刻X等分线  Mark X Bisectrix

设置X比例参数  Set X Scale Parameter
标刻Y等分线  Mark Y Bisectrix 
设置Y比例参数  Set Y Scale Parameter  

使用配置文件  Use Configuration File
参数另存为  Save Parameter As
确定  OK
关闭  Close

设置好等分线数，比如若要设置5mm一格，则对于工作区域为120mm的振镜，设定等分数为25。

Set the number of bisectrices. For example, if you want to set 5mm/grid, set the number of bisectrices to 25 for the galvanometer with a working area of 120mm.

点击“标刻X等分线”，测量各等分线到中线的距离，点击“设置X比例参数”，显示等分参数界面。

Click “Mark X Bisectrix”, measure the distance from each bisectrix to the center line, and click “Set X Scale Parameter” to display the equal parameter interface.
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设置测量数据  Set Measurement Data 
设定值  Setting Value 

实测值  Actual Value 

[中心线]  [Center Line]

确定  OK
关闭  Close

在等分参数界面中的表格内，将测量值输入实测值列。点击“确定”使数据生效。

Enter the measured value into the actual value column in the table of the equal parameter interface. Click “OK” to make the data effective.

同样操作，设置好Y等分值。

Similarly, set the Y equal value.

10.2.4.Save
Click "Save" to save the parameters using the current file name (or default file name); click "Save Data As" to save the file using another file name.

The saved file can be used for data correction of the marking software.

10.3. 九点校正 Nine Point Correction
用于精度要求比较高的场合。

It is used for occasions with high precision requirements.

校正前的相关参数设置 

Relevant Parameter Setting Before Correction

在主界面右边标刻参数栏中选择，打开参数设置。快捷键为F3。
Select in the marking parameter column on the right side of the main interface to open the parameter setting. The shortcut key is F3.

确定场镜范围，以120mm为例，把区域尺寸的参数改成120。

Determine the field lens range, take 120mm as an example, change the parameter of area size to 120.

设置好振镜方向，如下图。
Set the galvanometer direction, as shown below.
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配置参数 Configuration Parameters
区域  Area 
激光控制  Laser Control 
端口  Port  

高级参数  Advanced Parameters 

飞行标刻  Flight Marking
其它  Others 
红光指示  Red Light Indicator 

板卡信息  Board Information

外观  Appearance 
区域尺寸  Area Size 

偏移X  Offset X   
偏移Y  Offset Y 

角度  Angle 

最大线长  Maximum Line Length 

使用校正文件  Use Correction File 

XY互换  XY Interchange 

X反向  X Reverse  
Y反向  Y Reverse  

加工后去指定位置  Go to the Designated Position After Processing

不移动  Do Not Move 
振镜中心  Galvanometer Center 

对象左上角  Upper Left Corner of Object 

对象右上角  Upper Right Corner of Object 

对象右下角  Lower Right Corner of Object  

对象左下角  Lower Left Corner of Object  

指定位置  Designated Position
振镜1  Galvanometer 1
比例  Scale
振镜2  Galvanometer 2
比例  Scale
密码  Password
密码  Password
使用配置文件  Use Configuration File
参数另存为  Save Parameter As
确定  OK
关闭  Close
图9-1 区域参数

Figure 9-1 Area Parameters

10.3.1开始校正 Start Correction

从菜单进入 “九点校正”，进入九点校正操作界面。

Enter "Nine Point Correction" from the menu and enter the nine point correction operation interface.
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初值校正  Initial Value Correction
九点校正  Nine Point Correction
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振镜校正  Galvanometer Correction
C:\Users\liuxy\Desktop\标准卡\简版\5.2.1.simple.build20191129.a\sea.cor

C:\Users\liuxy\Desktop\standard card\simplified version\

5.2.1.simple.build20191129.a\sea.cor

区域尺寸  Area Size 

检定区域  Verification Area
重置  Reset  

序号  Serial Number 

X设定值  X Setting Value 

Y设定值  Y Setting Value
X实测值  X Actual Value 

Y实测值  Y Actual Value
标刻最大图形  Maximum Marking Graph  
停止标刻  Stop Marking 

标刻9点矩形  Marking 9 Point Rectangle 

导入测量值  Import Measured Value 
多点校正  Multi-dot Correction 
校正点数： Correction Points: 

校正标记尺寸  Correct Marking Size 

标刻校正点  Marking Correction Point 
标刻验证图形  Marking Verification Graph 
关闭  Close
10.3.2标刻校正图形 Marking Correction Graphs

新建一个校正文件，然后设置检定区域为100mm，重置。

Create a new correction file, then set the verification area to 100mm, and reset.

点击“标刻9点矩形”，可以标刻出下面的图形（x，y用于说明图形方向，不会实际标刻），注意其中的短线段和左上角的三角形的方向与位置必须跟下图一致，若不一致，则调整主界面的XY互换、X反向、Y反向参数，直到标刻出的图形与上图形状方向相同为止。

Click "Mark Nine Point Rectangle" to mark the following graph (x, y are used to illustrate the direction of the graph, but not the actual marking). Note that the direction and position of the short line segment and the triangle in the upper left corner must be consistent with the figure below. If it is not consistent, then adjust the XY interchange, X reverse and Y reverse parameters of the main interface until the marked graphs are in the same direction as the figure above.
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测量点的坐标时，尽可能减少测量误差。依次测量上图中的9个点的坐标值，基于中心点（5号点）进行，顺序号如下图所示：

When measuring the coordinates of points, the measurement error should be reduced as much as possible. Measure the coordinate values of 9 points in the above figure in turn, based on the center point (point 5), and the sequence number is as shown in the following figure: 
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以十字中心线（过5号点的直线与坐标轴）为基准，依次测量9个点的坐标值，并记录。测量方法为游标卡尺一边与十字中心线的X轴或者Y轴重合，另外一边与要测量的点重合，这个时候读数就是校正值。或者使用二次元测量。如图9-5取第1点校正值为例：（可以考虑测量3次取平均值的方法会更加精确）

Take the cross center line (straight line and coordinate axis passing point 5) as the benchmark, measure the coordinate values of 9 points in turn and record. The measurement method is that one side of the vernier caliper coincides with the X-axis or Y-axis of the cross center line, and the other side coincides with the point to be measured. At this time, the reading is the correction value. Or use the quadratic element measurement. As shown in Figure 9-5, take the correction value of point 1 as an example: (it can be considered that the method of measuring for three times to take the average value, which will be more accurate)

将测量值填充到数据表中的第4、5列。其中第2、3列为设定的距离，4、5两列为对应的实际标刻距离，注意测量值是有正负的。
Fill the measured values into columns 4 and 5 of the data table. In which, the columns 2 and 3 are the set distances, and the columns 4 and 5 are the  corresponding actual marking distances. Note that the measured values are positive and negative.

点击“保存”，保存文件（这里保存为9dot.cor）如图9-9；

Click “Save” to save the file (here save as 9dot. cor), as shown in Figure 9-9;
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收藏夹 Facorites
下载 Downloads
桌面 Desktop 

最近访问的位置 Last Visited Location
2345下载  2345 Downloads
库 Library
视频 Videos
图片 Images
文档 Documents
音乐 Music
名称 Name 

修改日期 Modified Date 

类型  Type 
大小  Size 

文件名（N）:   File Name (N): 
保存类型（T）：  Save Type (T):
隐藏文件夹 Hide Folders
保存  Save 
取消 Cancel
图9-9 保存校正文件

Figure 9-9 Save Correction File

保存后，可以点击“标刻验证图形”，将标刻校正后图形，如下图：
After saving, you can click the “Marking Verification Graph” to mark the corrected graphs, as shown below:
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10.3.3使用校正文件 Use Correction File
在配置参数里使用校正文件，如下图9-10，勾选使用校正文件，选中对应的9dot.cor文件即可。
Use the correction file in the configuration parameters, as shown in Figure 9-10 below. Check the use correction file and select the corresponding 9dot.cor file.
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配置参数 Configuration Parameters
区域  Area 
激光控制  Laser Control 
端口  Port  

其它  Others 
板卡信息  Board Information

外观  Appearance 
区域尺寸  Area Size 

偏移X  Offset X   
偏移Y  Offset Y 

振镜1 = X  Galvanometer 1 = X
振镜2 = X  Galvanometer 2 = X
使用校正文件  Use Correction File

D:\用户目录\Documents\9dot.cor  D:\user directory\Documents\9dot.cor
振镜1  Galvanometer 1 
反向  Reverse
比例  Scale
振镜2  Galvanometer 2 
反向  Reverse
比例  Scale
使用配置文件  Use Configuration File 

加工后去指定位置  Go to the Designated Position After Processing

不移动  Do Not Move 
振镜中心  Galvanometer Center 

对象左上角  Upper Left Corner of Object 

对象右上角  Upper Right Corner of Object 

对象右下角  Lower Right Corner of Object  

对象左下角  Lower Left Corner of Object  

指定位置  Designated Position
密码  Password
密码  Password
参数另存为  Save Parameter As
标刻参数栏  Marking Parameter Bar
打开  Open
库  Library
文档  Documents
组织  Organization
新建文件夹  New Folder
收藏夹 Facorites
库 Library
视频 Videos
图片 Images
文档 Documents
音乐 Music
计算机  Computer 

本地磁盘（C:）  Local Disk (C:) 
本地磁盘（D:）  Local Disk (D:)  

本地磁盘（E:）  Local Disk (E:) 
网络  Network 

文档库  Document Library 

包括：2个位置  Including: 2 Positions
排列方式：文件夹  Arrangement: Folders
文件名（N）：  File Name (N): 
打开  Open
取消 Cancel
使用校正文件

Use Correction File
10.3.4均匀度校正与高精度调校Uniformity Correction and High Precision Adjustment

经过区域校正后，一般来说精度可以达到要求，若均匀度不能满足要求，可在x，y方向上增加等分比例校正。

After the area correction, generally speaking, the precision can meet the requirements. If the uniformity can not meet the requirements, you can increase the equal scale correction in the x and y directions.

勾选“等分比例法”，出现如下界面：

Check the “Equal Scale Method” and the following interface appears:

10.3.4.1 X方向比例参数调整 Scale Parameter Adjustment in X Direction

第一步，点击“标刻X比例线”,程序延X轴方向标刻出由短渐长的短线。

Step 1, click "Mark X Scale Line", the program marks the short line from short to long along the X-axis direction.

第二步，点击“设置X比例参数”，进入比例值设置界面。

Step 2, click “Set X Scale Parameter” to enter the scale value setting interface.
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设置测量数据  Set Measurement Data 
设定值  Setting Value 

标刻值  Marking Value 

[中心线]  [Center Line]

确定  OK
取消 Cancel
按图中描述的顺序，依次测量短线到中心线之间的距离（mm），并填入右侧表格中，点确定返回主界面。

According to the sequence described in the figure, measure the distance (mm) from the short line to the center line in turn, fill it in the table on the right, and click OK to return to the main interface.

第三步，点击“标刻X测试线”，程序沿X轴向，标刻出一系列由短渐长的等分（对检定区域的大小进行20 等分，比如检定区域为100mm，则相邻等分线之间的标准距离为5mm）短线，测量各短线与中心线之间的距离。如果某个间隔大于标准等分距离，则需要将比例参数距离调大，若小于标准等分距离，则需要将比例参数调小。

Step 3, click “Mark X Test Line”, the program marks a series of equal (20 equal parts for the size of the verification area, for example, if the verification area is 100 mm, the standard distance between adjacent bisectrices is 5 mm) short lines along the X-axis direction, and measures the distance between each short line and the center line. If a certain interval is greater than the standard equal distance, you need to increase the scale parameter distance; if it is smaller than the standard equal distance, you need to decrease the scale parameter.

例如，若测量得到图中线5与线6的间距为4.9，（假定6，7，8，9，10均正确），则此时线5与中心线的距离为29.9。根据图2-13中所填入的数据，此数值位于“6”和“7”之间。根据上述规则，我们需要调整其中较大的“6”中的数据，因4.9小于5，因此需要将原值30.8减小。

For example, if the measured spacing between line 5 and line 6 in the figure is 4.9, (assuming that 6, 7, 8, 9 and 10 are correct), then the distance between line 5 and the center line is 29.9. According to the data filled in Figure 2-13, this value is between “6” and “7”. According to the above rules, we need to adjust the data in the larger “6”, 4.9 is less than 5, so we need to reduce the original value of 30.8.

10.3.4.2 Y方向比例参数调整
Scale Parameter Adjustment in Y Direction

操作步骤与9.2.5.1一样。

The operation steps are the same as 9.2.5.1.

11. Help
11.1. About SEACAD
Click "About SEACAD" to display the software version information.

11.2. 重置工作区布局Reset Workspace Layout

如果软件出现界面显示错误，或者窗口状态异常等问题，可以通过该功能重置成初始状态；

If the software appears the interface display error, or abnormal window state and other problems, you can reset it to the initial state through this function;

如果用户之前有使用我们的标刻软件，在更新版本之前，我们建议客户先重置一次工作区布局以免由于不兼容导致程序在打开的时候出现不可预知的错乱。

If the user has used our marking software before, before updating the version, we recommend that the customer should reset the workspace payout first to avoid unpredictable disorder when the program is opened due to incompatibility.

注意：使用该功能需要手动重启本程序。

Note: To use this function, you need to restart the program manually.

11.3. 板卡注册 Board Registration
客户购买或试用板卡，需要根据销售方的要求进行板卡的注册。
If customers want to purchase or try out the boards, they need to register the boards according to the requirements of the sellers.

作为对客户和销售方的限制，本程序在没有检测到任何的已经正式注册（无使用限制）或者试用期注册（有使用时长限制，具体时长请咨询销售方）的板卡的时候，是不允许客户进行标刻（包括红光）和保存操作的，而且软件也会有30分钟的使用限制，30分钟之后将强制退出程序；

As a restriction on customers and sellers, the program does not allow customers to mark (including red light) and save when it does not detect any board that has been officially registered (without restrictions on use) or registered during the probation period (with restrictions on service time, please consult the sellers for specific time), and the software will also have a 30-minute use restriction. After 30 minutes, the program will be forced to exit;

仅需一张板卡处于正式注册或试用期注册时，软件将会解除所有的限制，但对于没有正式注册或者已经超过试用期的板卡，仍然无法标刻和红光（只能在板卡注册界面查看到相关的板卡）。

When only one board is in the formal registration or probation period registration, the software will release all restrictions, but for the boards that have not been formally registered or have exceeded the probation period, they still cannot be marked and red light (only the relevant boards can be viewed in the board registration interface).

板卡注册方法如下图所示：

The board registration method is shown in the following figure:
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板卡注册  Board Registration
序号  Serial Number 

版本  Version 

板卡ID  Board ID

注册码  Registration Code  
状态  State 

已注册  Registered 
注册密钥  Registration Key 

注册  Registration 
关闭  Close

把注册码发给您的供应商。

从供应商那里得到注册密钥。
把注册密钥输入到注册密钥对应的位置。
点击注册后静待数秒后，弹出注册成功框确定完成注册。
1. Send the registration code to your supplier.

2. Obtain the registration key from the supplier.

3. Enter the registration key to the corresponding location of the registration key.

4. After clicking on the registration and waiting for a few seconds, the registration success box will pop up to confirm the completion of registration.

11.4. Help documentation
Click "Help Documentation" to open the software manual directly.

Apply to copy object





Apply









